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4 The Windows Initialization Files 

This chapter describes the contents of the key Microsoft Windows initialization 
files, WIN.INI  and SYSTEM.INI, plus other Windows initialization files. This 
chapter also describes how you can change entries in the files. 

Note If you want to reinstall Windows and preserve the settings in the current 
initialization files on your system, follow the procedures outlined in Flowchart 
1.5, “Reinstalling Windows without Losing Settings.” 

Related information •••• Windows User’s Guide:  Chapter 5, “Control Panel”; Chapter 15, 
“Maintaining Windows with Setup” 

•••• Windows Resource Kit:  Chapter 2, “The Windows Setup Information Files” 

Contents of this chapter 

About the Initialization Files ............................................................................158 
Format of .INI  Files ...................................................................................158 
Changing Entries in .INI  Files....................................................................159 
Editing the .INI  Source Files......................................................................161 
Windows 3.1 .INI  File Changes.................................................................161 

WIN.INI :  The Windows Initialization File .......................................................163 
SYSTEM.INI:  The System Initialization File....................................................183 
Other Windows Initialization Files...................................................................219 

PROGMAN.INI: The Program Manager Initialization File.........................219 
CONTROL.INI:  Control Panel Initialization File.......................................222 
WINFILE.INI :  The File Manager Initialization File ..................................223 



158 Part 1   Installation and Setup 

Windows Resource Kit   

About the Initialization Files 

The Windows initialization files contain information that defines your Windows 
environment. Microsoft Windows and the Windows applications use the 
information in these files to configure themselves according to your needs and 
preferences. 

The standard Windows initialization files are CONTROL.INI, PROGMAN.INI, 
SYSTEM.INI, WIN.INI , and WINFILE.INI . Other Windows applications may also 
add .INI  files in the WINDOWS directory. 

.INI File File contents 

WIN.INI Entries that you can set to alter the Windows environment according to 
your preferences. 

SYSTEM.INI Entries that you can set to customize Windows to meet your system’s 
hardware needs. 

CONTROL.INI Entries that describe the color schemes and patterns used in Windows, 
and the settings for printers and installable drivers. 

PROGMAN.INI Entries that define content of program groups. 

WINFILE.INI Entries that define the appearance and behavior of items in File Manager. 

application.INI Entries created and maintained by a specific Windows application. 
The file is created when the application is installed. 
 

Important    Errors made by editing initialization files can lead to undesirable 
results when you run Windows. Before changing any entry, make a backup copy 
of the file. Read “Changing Entries in .INI  Files” later in this chapter for 
guidelines. 

Format of .INI Files 

Windows initialization files are broken into logical groups called sections. Each 
section has this format: 

[section] 
keyname=value 

Item Meaning 

[section]  The name of a section. The enclosing brackets ([]) are required, and the left 
bracket must be in the leftmost column on the screen. 

keyname The name of an entry, which can consist of any combination of letters and 
digits. For many entries, the keyname must be followed immediately by an 
equal sign (=).  

value  An integer, a string, or a quoted string, depending on the entry. 
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For many entries, the value is shown as Boolean. To enable an entry that 
requires a Boolean value, you can enter True, Yes, On, or 1. To disable such an 
entry, you can enter False, No, Off, or 0. Case doesn’t matter. 

To include comments in .INI  files, begin each line of comment with a semicolon 
(;). 

The order of the sections in an .INI file is not important. Some Windows 
applications may add or insert other sections. The entries in each section are 
listed alphabetically in this chapter, but they do not appear in this order in the 
.INI  files. So to change an entry, you must search for it within the section. 

In this chapter, the items that apppear in bold are actual words included in the 
entry. Values that must be substituted in the entry are shown in italics. When the 
value can be one of several choices, the choices are separated with a pipe 
character ( | ). For example: 

Beep=Yes | No  

Any entry listed here that does not appear in your .INI  file has the default value. 
Default values are shown for all the entries in this chapter. 

Changing Entries in .INI Files 

Windows creates the initialization files during installation and assigns default 
values. Some entries are added or changed when you install or configure a 
Windows application. You can edit these entries to change the appearance 
or performance of Windows. There are several ways to change entries in the .INI  
files: 

•••• Use Control Panel, Program Manager, or File Manager to change many 
entries with menu commands and dialog box options.  

•••• Run Windows Setup again to change system settings, the keyboard or 
mouse configuration, or network options, and to add or remove printers and 
fonts. 

•••• Use a text editor such as Notepad to edit the file directly.  

•••• Choose a command such as Printer Setup from the File menu in Print 
Manager, and specify new options. 
 

The entries in this chapter show which entries in WIN.INI  and SYSTEM.INI you 
can change with Control Panel or Setup to avoid editing the .INI  file directly, 
where it is easy to make editing mistakes. For the entries you cannot change with 
Control Panel or Setup, you must edit the .INI  file with a text editor. 
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Important    Always back up the .INI  file before you open it, and use care when 
making changes. Incorrect changes can lead to unexpected results when you run 
Windows. Also, some editors can damage characters with ANSI values of greater 
than 127. We recommend that you use Control Panel or Setup whenever 
possible to make changes. If you must edit the file, use a text editor such as 
Notepad, System Editor, or Edit (the MS-DOS 5.0 text editor).  

To change .INI file entries with a text editor: 

1. Important    Create a backup copy of the .INI  file you want to edit. 

2. Open the .INI  file with a text editor such as Notepad. 

3. Edit the specific entries and save the file. 

4. Restart Windows so the changes will take effect. 
 

You can use the System Editor utility in Windows to edit SYSTEM.INI, WIN.INI , 
CONFIG.SYS, and AUTOEXEC.BAT at the same time. The System Editor is 
installed in your WINDOWS directory by Windows Setup. 

To edit system files with System Editor: 

1. Important    Create a backup copy of the .INI  file you want to edit. 

2. Choose Run from the File Menu in Program Manager. Type sysedit and 
press ENTER. 

3. Click the window in System Editor that contains the file you want to edit. 

 

Figure 4.1 
 
 
The System Editor in 
Windows 3.1 
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4. Edit the file, using the same text editing  techniques as in Notepad. 

5. Save the file, and choose Exit from the File menu to close System Editor. 

6. Restart Windows so that the changes you made can take effect. If you edit 
CONFIG.SYS or AUTOEXEC.BAT, you must reboot your system for the 
changes to take effect. 
 

Editing the .INI Source Files 

If you copy the Windows files to a network server using the setup /a option (to 
install a shared copy of Windows), Setup uses WIN.SRC, SYSTEM.SRC, and 
CONTROL.SRC to build WIN.INI , SYSTEM. INI, and CONTROL.INI when a user 
installs Windows on a workstation with the setup /n option. To create custom 
initialization files for multiple installations, you can change the .SRC files. 

To edit the .SRC files, first save a backup copy of the original file, then make 
editing changes in the file, following the guidelines in this chapter. Save the file 
with an .SRC filename extension in the WINDOWS directory on the network 
server. And, of course, test the new .INI  file on a single system before installing 
Windows on multiple systems. 

Windows 3.1 .INI File Changes 

W If you update to Windows, Setup automatically updates the .INI files with the 
following changes. Setup leaves all other sections and entries in your existing 
WIN.INI  and SYSTEM.INI unchanged when you upgrade to Windows 3.1. 

For the WIN.INI  file: 

•••• In the [Windows] section, Setup adds three new entries: 

 KeyboardDelay= 
 ScreenSaverTimeout= 
 DosPrint= 

 If the following entries are present in the 3.0 version of WIN.INI , Setup does 
not change them. If they are not present, Setup adds them: 

 device= 
 documents= 
 programs=com exe bat pif 
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•••• In the [extensions] section, Setup adds bmp=prush.exe ^.bmp, and also 
adds pcx=pbrush.exe ^.pcx and rec=recorder.exe ^.rec if they are not 
already in WIN.INI : 

•••• In the [intl] section, Setup changes sLanguage=English (American) 
to sLanguage=enu. 

•••• In the [ports] section, Setup adds LPT1.DOS and LPT2.DOS. If they are 
not already present in WIN.INI, Setup adds these three entries: 

 file:= 
 com3:=9600,n,8,1,x 
 com4:=9600,n,8,1,x 

•••• Setup adds [fontSubstitutes] and [TrueType] to support TrueType fonts. 
The default [fontSubstitutes] entries are: 

 Helv=MS Sans Serif 
 Tms Rmn=MS Serif 
 Times=Times New Roman 
 Helvetica=Arial 

•••• Setup adds the [mci extensions] section, with these entries to support 
multimedia: 

 wav=waveaudio 
 mid=sequenccer 
 rmi=sequencer 

•••• Setup adds the [sound] section, with these entries to support multimedia: 

 SystemDefault=ding.wav, Default Beep 
  SystemExclamation=chord.wav, Exclamation 
  SystemStart=tada.wav, Windows Start 
 SystemExit=chimes.wav, Windows Exit 
 SystemHand=chord.wav, Critical Stop 
 SystemQuestion=chord.wav, Question 
 SystemAsterisk=chord.wav, Asterisk 

•••• Setup adds the [embedding] section, with these entries to support Object 
Linking and Embedding: 

 SoundRec=Sound,Sound,SoundRec.exe,picture 
 Package=Package,Package,packager.exe,picture 
 PBrush=Paintbrush Picture,Paintbrush Picture,pbrush.exe,picture 

For the SYSTEM.INI file: 

•••• In the [386enh] section, Setup adds device= entries if it encounters Western 
Digital–compatible protected mode block devices in your system. 

•••• One new section, [drivers], contains a list of aliases for installable drivers, 
and another new section, [mci], lists the Media Control Interface drivers. 

•••• Many other changes in communications and enhanced mode capabilities for 
Windows 3.1 have created new entries in the [386enh] section. 
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WIN.INI:  The Windows Initialization File 

The WIN.INI  file contains several sections, each of which consists of a group 
of related entries that you can use to customize the Windows environment. A 
specific WIN.INI  file might not have all of these sections, or it might have addi-
tional sections, depending on your system’s hardware and software require-
ments. For example, many Windows applications add entries in WIN.INI  to 
define user preferences and other items. 

 W For Windows 3.1, the size of WIN.INI  is no longer limited to 32K. 

These basic sections can appear in WIN.INI  after you first install Windows. 

Section Purpose 

[Windows] Affects several elements of the Windows environment. 

[desktop] Controls the appearance of the desktop and the position of windows and 
icons. 

[extensions] Associates specified types of files with corresponding applications. 

[intl] Describes how to display items for countries other than the United States. 

[ports] Lists all available output ports.  

[fonts] Describes the screen font files that are loaded by Windows.  

[fontSubstitutes] Lists pairs of fonts that are recognized by Windows as interchangeable. 

[TrueType] Describes options for using and displaying TrueType fonts. 

[mci extensions] Associates specified types of files with Media Control Interface devices. 

[network] Describes network settings and previous network connections. 

[embedding] Lists the server objects used in Object Linking and Embedding (OLE). 

[Windows Help] Lists settings used to specify the default size, placement, and text colors of 
the Help window and dialog boxes. 

[sound] Lists the sound files assigned to each system event. 

[printerPorts] Lists active and inactive output devices to be accessed by Windows.  

[devices] Lists active output devices that provide compatibility with earlier versions of 
Windows applications.  

[programs] Lists additional paths that Windows will search to find a program file when 
you try to open an associated data file. 

[colors] Defines colors for the Windows display.  
 

More sections can be inserted in WIN.INI  by other Windows applications, 
although some applications set up their own .INI  files. For information about 
those sections, see the application’s documentation. 
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[Windows] Section 

This section contains entries that affect these parts of the Windows environment: 

•••• Applications that start when you start Windows 
•••• Warning beep 
•••• Printing 
•••• Window border width 
•••• Keyboard speed 
•••• Mouse settings 
•••• Definition of files as documents or programs 

 
The [Windows] section can contain the following entries: 

Beep=Yes | No  

This entry specifies whether Windows sounds a warning beep when you attempt 
to do something that is not allowed. The default is Yes. To change this entry, 
choose the Sound icon from Control Panel. For entries that control multimedia 
sound, see the description of [sound] section later in this chapter. 

BorderWidth=number  

This entry sets the width of the borders around all the windows that have 
sizeable borders. The possible range is 1 (narrowest) to 49 (widest). The default 
is 3. To change this entry, choose the Desktop icon from Control Panel. 

 W CoolSwitch=0 | 1 

This entry turns fast task switching on or off. The default is 1. To change this 
entry, choose the Desktop icon from Control Panel and check or clear the Fast 
ALT+TAB  Switching option. 

CursorBlinkRate=milliseconds  

This entry indicates how much time elapses between each blink of the selection 
cursor. The default is 530. To change this entry, choose the Desktop icon from 
Control Panel. 

W DefaultQueueSize=number 

This entry specifies the number of messages an application’s message queue can 
hold. The default is 8. To change this entry, you must edit WIN.INI . (You should 
never need to change this entry.) 
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Device=output-device-name, device-driver, port-connection  

This entry defines the default printer. The output-device-name can be any device 
name listed in the [devices] section. An explicit port and driver must be assigned 
to the device. The device-driver is the filename (without the extension) of the 
device driver file. The port-connection is any port in the [ports] section. The 
default is none. To change this entry, choose the Printers icon from Control 
Panel or choose Printer Setup from the Option menu in Print Manager. 

DeviceNotSelectedTimeout=seconds  

This entry specifies how much time Windows waits for a device to be switched 
on. An entry is saved for each printer listed in the [printerPorts] section. If the 
device is not switched on during this time, Windows won’t print to the device. 
For some devices, Windows immediately posts an error message if the device is 
not already switched on. The default is 15. To change this entry, you must edit 
WIN.INI . This entry only defines the system default value. To change the value 
for a particular printer, choose the Printers icon from Control Panel, which 
changes the corresponding value only in the [printerPorts] section. 

 W Documents=extensions  

This entry defines files to be considered “documents” by Windows. Use this 
entry to define only document file extensions not listed in the [extensions] 
section, because those extensions are automatically considered documents. The 
extensions listed in this entry are not associated with any application. Separate 
the filename extensions with a space, and do not include the preceding periods. 
The default is none. To change this entry, you must edit WIN.INI . 

 W DosPrint=Yes | No 

This entry specifies whether Windows should use MS-DOS interrupts when 
printing. When this entry is Yes, MS-DOS interrupts are used; if the value is No, 
printing output is sent directly to the port that the printer is assigned to. The 
default is No. To change this entry, choose the Printers icon from Control Panel 
or the Printer Setup command from the Print Manager Options menu, then clear 
the Fast Printing Direct To Port option in the Connect dialog box. 

W DoubleClickHeight=pixels 
DoubleClickWidth=pixels 

These entries specify the height and width (in pixels) that the mouse pointer can 
move between clicks in a double-click. If the mouse pointer is moved farther up 
or down (or left or right), the two clicks will be treated as separate single clicks. 
For example, if DoubleClickHeight=10, the mouse pointer cannot move 
vertically more than 5 pixels between clicks for the two clicks to be recognized 
as a double-click. If you enter an odd number, it is rounded to the nearest even 
number. The default is 4 for both entries. To change these entries, you must edit 
WIN.INI . 
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DoubleClickSpeed=milliseconds  

This entry sets the maximum time between clicks of the mouse button that the 
system will permit for one double-click. The lower the value for this entry, the 
less time you have to click twice to double-click. The default is 452. To change 
this entry, choose the Mouse icon from Control Panel. 

 W KeyboardDelay=milliseconds 

This entry establishes how much time elapses after you hold down a key before 
the key starts to repeat. The default is 2. To change this entry, choose the 
Keyboard icon from Control Panel. 

KeyboardSpeed=milliseconds  

This entry sets how much time elapses between repetitions of a character on the 
display when you hold down a keyboard key. This entry does not work for all 
keyboards. The default is 31. To change this entry, choose the Keyboard icon 
from Control Panel. If you delete this entry from WIN.INI , Windows Setup will 
not reset the speed, but the speed will still be set if you choose the Keyboard 
icon in Control Panel, even if you cancel the dialog box.  

Load=filename(s)  

This entry specifies the applications to be run as icons when Windows is started. 
This entry is a list of application filenames, or documents associated with an 
application, with each filename separated by a space. Make sure to specify the 
path if the file is not located in the WINDOWS directory. The default is none. To 
change this entry, add the application to the Startup group in Program Manager, 
then check Minimize On Use in the Properties dialog box. 

 W MenuDropAlignment=0 | 1 

This entry specifies whether menus open so that they are right aligned or left 
aligned with the menu title. If this entry is 0, menus open so that they are left 
aligned. If it is 1, menus open so that they are right aligned. The default is 0. To 
change this entry, you must edit WIN.INI . 

 W MenuShowDelay=milliseconds  

This entry specifies how long to wait before displaying a cascading menu. The 
default is 0 for 80386 computers; 400 for 80286 computers. To change this 
entry, you must edit WIN.INI . 
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MouseSpeed=0 | 1 | 2  

This entry sets the relationship between mouse and cursor movement when 
the value of either MouseThreshold1= or MouseThreshold2= is exceeded. 
When this occurs, Windows causes cursor movement to accelerate according 
to the value of MouseSpeed=. If the value is 0, there is no acceleration. If 
the value is 1, the cursor is moved twice the normal speed when mouse move-
ment exceeds the value of MouseThreshold1=. If the value is 2, the cursor is 
moved twice the normal speed when the mouse movement exceeds the value 
of MouseThreshold1=, or four times the normal speed if mouse movement 
exceeds MouseThreshold2=. The default is 1. To change this entry, choose 
the Mouse icon from Control Panel. 

MouseThreshold1=pixels 
MouseThreshold2=pixels  

These entries set the maximum number of pixels that the mouse can move 
between mouse interrupts before Windows alters the relationship between mouse 
and cursor movement. If the mouse movement exceeds the threshold defined by 
MouseThreshold1= and if MouseSpeed= is greater than 0, Windows moves the 
cursor at twice the normal speed. If the mouse movement exceeds the threshold 
defined  by MouseThreshold2= and if MouseSpeed=2, Windows moves the 
cursor at four times the normal speed. The defaults are MouseThreshold1=5 
and MouseThreshold2=10. To change these entries, choose the Mouse icon 
from Control Panel. 

 W MouseTrails=number 

This entry specifies the number of pointers shown on the screen when the 
MouseTrails option is selected in the Mouse dialog box in Control Panel. You 
can specify a number between 1 and 7. This entry is supported only if you are 
using the EGA, VGA, or SuperVGA display driver. The default is none. To 
change this entry, choose the Mouse icon from Control Panel. If the Mouse 
dialog box does not include the Mouse Trails option, you need to add this entry 
to WIN.INI  to set mouse trails.  

NetWarn=0  | 1  

This entry specifies whether Windows should display a warning message if the 
system is configured to run a network and the network is not running or the 
wrong network is running. All Windows network-related options will be dis-
abled if the network is disabled or incorrect. Setting this value to 0 turns off 
the warning message. The default is 1. To change this entry, choose the Network 
icon from Control Panel. 
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NullPort=string  

This entry specifies the name used for a null port. This name appears in the 
Printers Connect dialog box in Control Panel when a device is installed (that is, 
the device driver is present) but is not connected to any port. This value also 
appears for such a device in the [devices] section of WIN.INI . The default is 
"None". To change this entry, you must edit WIN.INI . 

Programs=extensions  

This entry defines which files Windows regards as applications. Separate the 
filename extensions with a space and do not include the preceding periods. The 
default is com exe bat pif. To change this entry, you must edit WIN.INI . 

Run=filename(s) 

This entry tells Windows to run the specified applications when Windows is 
started. The value is a list of application filenames or documents associated with 
applications, with each filename separated by a space. Make sure you specify the 
complete path if the file is not in the WINDOWS directory. The default is none. 
To change this entry, add the application to the Startup group in Program 
Manager. 

 W ScreenSaveActive=0 | 1 

This entry specifies whether a screen saver should be displayed if Windows is 
not actively being used. Set this value to 1 to use a screen saver; 0 turns off the 
screen saver. The default is 0. To change this entry, choose the Desktop icon 
from Control Panel. 

 W ScreenSaveTimeOut=seconds 

This entry specifies the amount of time that Windows must be idle before the 
screen saver appears. The default is 120. To change this entry, choose the 
Desktop icon from Control Panel. 

Spooler=Yes | No  

This entry specifies whether output to the printer is to be sent through Print 
Manager. Changing this value to No turns off Print Manager. The default is Yes. 
To change this entry, choose the Printers icon from Control Panel and check or 
clear the Use Print Manager option. 
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 W SwapMouseButtons=0 | 1 

This entry specifies whether to swap the right and left mouse buttons. If the 
value is 1, the buttons are swapped. The default is 0. To change this entry, 
choose the Mouse icon from Control Panel. 

TransmissionRetryTimeout=seconds  

This entry specifies the default amount of time to give Windows for attempted 
transmission retries. A value is saved for each printer in the [printerPorts] 
section. If a successful transmission does not occur during this time, Print 
Manager displays a message stating that the printer is not receiving characters. 
The default is 90 for PostScript printers; 45 for all other printers. To change this 
entry, you must edit WIN.INI . This setting serves only as the system default 
value. To change the value for a particular printer, choose the Printers icon from 
Control Panel or choose Printer Setup from the Options menu in Print Manager. 
Changing this setting with Control Panel or Print Manager changes the 
corresponding value only in the [printerPorts] section. 

[desktop] Section 

The [desktop] section contains entries that control the appearance of the screen 
background and the position of windows and icons on the screen. This section 
can contain the following entries: 

GridGranularity=number  

This entry specifies the size of the grid that Windows uses to position windows 
on the screen. The possible range is 0 through 49, in units of 8 pixels. The 
default is 0. To change this entry, choose the Desktop icon from Control Panel. 

IconSpacing=pixels  

This entry specifies the number of pixels that appear horizontally between icons. 
A larger number increases the space between icons. The default is 77. To change 
this entry, choose the Desktop icon from Control Panel. 

 W IconTitleFaceName=fontname 

This entry specifies the font used to display icon titles. Change this value if the 
icon title is difficult to read. The default is MS Sans Serif. To change this entry, 
you must edit WIN.INI . 

 W IconTitleSize=number 

This entry specifies the size of the font used to display icon titles. Change this 
value if the icon title is difficult to read. The default is 8. To change this entry, 
you must edit WIN.INI . 
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 W IconTitleWrap=0 | 1 

This entry specifies whether to wrap icon titles. A value of 1 allows icon title 
wrapping and increases icon vertical spacing by three lines; 0 turns off icon title 
wrapping. The default is 1. To change this entry, choose the Desktop icon from 
Control Panel. 

 W IconVerticalSpacing=pixels 

This entry specifies the number of pixels that will appear vertically between 
icons. Increasing this number increases the amount of vertical space between 
icons. Windows determines the default value based on the icon title font and the 
display you are using. To change this entry, you must edit WIN.INI . 

 W Pattern=b1 b2 b3 b4 b5 b6 b7 b8  

This entry specifies a pattern for the screen background. The 8 numeric values 
define a bitmap 8 pixels wide and 8 pixels high. Each decimal value represents a 
byte, and each byte represents a row of 8 pixels, where 0 sets the corresponding 
pixel to the background color and 1 sets the corresponding pixel to the 
foreground color (specified by the Background= and WindowText= entries in 
the [colors] section, respectively). For example, if you set the b1 value to the 
decimal value 175, the top row of pixels in the bitmap appears as the binary 
equivalent (10101111). The default is "(None)" (this string appears when no 
pattern is specified). To change this entry, choose the Desktop icon from Control 
Panel. 

TileWallpaper=0 | 1  

This entry specifies that the desktop wallpaper is tiled across the screen if 
this value is 1. The wallpaper is centered if this value is 0. The default is 0. To 
change this entry, choose the Desktop icon from Control Panel. 

Wallpaper=bitmap-filename  

This entry supplies the filename for the bitmap on the screen background. 
Include the path if the file is not in the WINDOWS directory or SYSTEM 
subdirectory. The default is "(None)" (this string appears when no pattern is 
specified). To change this entry, choose the Desktop icon from Control Panel. 
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[extensions] Section 

The [extensions] section contains entries that identify document files with 
corresponding command lines, so that opening a document file automatically 
starts the application. The format for each entry is: 

extension=command-line 

Value Meaning 

extension  A filename extension of one to three characters.  

command-line  An ordinary MS-DOS command line. The command line always begins with 
an application filename (including the .EXE extension). This can be followed 
by any command parameters the application needs, usually including the 
document filename. The caret (^) character can be used when the original 
document filename is needed in the command line; the caret is replaced by 
the document filename without any extension.  
 

The most typical [extensions] entries simply list the application name and the 
document name; for example: 

CAL=CALENDAR.EXE ^.CAL 

If you run a file called MYFILE.CAL  after this association has been made, the 
Calendar program starts and automatically opens the file MYFILE.CAL . 

You can enter only one line per extension (.TXT, .INI, and others), but more than 
one line for any program (for example, separate lines to indicate that Write 
should be used for .TXT, .INI , and .WRI files). To change an entry in 
[extensions], choose Associate from the File menu in File Manager. Windows 
also updates this entry from any changes made in the Registration Info Editor. If 
an entry in [extensions] duplicates information in the registration database, File 
Manager uses the information from the database. 
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[intl] Section 

The [intl] section describes how to display dates, times, currency amounts, and 
other items for countries other than the United States. The default values reflect 
U.S. options. To change any entry in this section, choose the International icon 
from Control Panel. For details about the specific values for individual entries, 
see the WININI.WRI  file in your WINDOWS directory. 

The [intl] section can contain the entries shown in the following table. If the 
keyword begins with an “i” then the value is an integer; if the keyword begins 
with “s” then the value is a string. 

Entry Value 

iCountry=country Specifies the country code. This number matches the country’s international 
telephone code, except for Canada, which is 2. The default is 1. 

iCurrDigits=number Specifies the number of digits to put after the decimal separator in currency. 
The default is 2. 

iCurrency=number Specifies a currency format, where 0 = $2, 1 = 2$, 2 = $ 2, and 3 = 2. The 
default is 0. The actual currency symbol is specified by the sCurrency= 
value. 

iDate=number Specifies a numerical date format for compatibility with Windows 2.x, where 
0 = 12/31/90, 1 = 31/12/90, and 2 = 90/12/31. The default is 0. The actual 
date divider is specified by the sShortDate= value.   

iDigits=number Specifies the number of digits to display after the decimal separator in 
numbers. The default is 2. 

iLZero=0 | 1 Specifies whether to put leading zeros in decimal numbers, where 0 = .7 and 
1 = 0.7. The default is 0. The actual decimal separator is specified by the 
sDecimal= value. 

iMeasure=0 | 1 Specifies the measurement system as metric or English, where 0 = metric and 
1 = English. The default is 1. 

iNegCurr=number Specifies a negative number format, where:  

 0 = ($1)  3 = $1– 6 = 1–$  9 = –$ 1 

1 = –$1  4 = (1$) 7 = 1$–  0 = $ 1– 

2 = $–1  5 = –1$ 8 = –1 $   

 The default is 0. The actual currency symbol is specified by the sCurrency=  
value. 

iTime =number Specifies whether to format time using a 12-hour or 24-hour clock, where 
0 = 1:00 (12-hour clock) and 1 = 13:00 (24-hour clock). The default is 0. 
The actual time separator is specified by the sTime= value. 

iTLZero=number Specifies whether to put leading zeros in time, where 0 = 9:15 and 1 = 09:15. 
The default is 0. The actual time separator is specified by the sTime= value. 
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Entry Value  (continued) 

s1159=string Specifies the string that follows times before noon in the 12-hour time format. 
The default is AM. 

s2359=string Specifies the string that follows times after noon in the 12-hour format or 
that follows all times in the 24-hour format. The default is PM. 

sCountry=string Specifies the name of the country whose standard value you want to use. 
The default is United States. 

sCurrency=string Specifies the currency symbol you want to use. The default is $. 

sDecimal=string Specifies the punctuation used to separate the fractional part of a decimal 
number from the whole number part. The default is . (a period). 

sLanguage=string Specifies the language you want to work in. Windows applications that 
provide language specific tasks, such as sorting or spell checking, use this 
entry. The default is enu. Values are: 

 dan = Danish frc = French Canadian  

deu = German isl = Icelandic  

eng = International English ita = Italian  

enu = U.S. English nld = Dutch  

esn = Modern Spanish nor = Norwegian  

esp = Castilian Spanish ptg = Portuguese  

fin = Finnish sve = Swedish  

fra = French  

sLis=string Specifies the character used to separate items in a list. In U.S. English, the 
most common separator is a comma. The default is , (a comma). 

sLongDate=format Specifies your choices for the long date formats, including abbreviations for the 
words and separators. Control Panel will accept only certain format 
combinations. Therefore, you should use Control Panel to change these entries. 
The default is dddd, MMMM dd, yyyy (that is, Friday, June 1, 1990). Values 
are: 

 d = Day (1–31) MM = Month (01–12) 

dd = Day (01–31) MMM = Month (Jan–Dec) 

ddd = Day (Mon–Sun) MMMM = Month (January–December) 

dddd = Day (Monday–Sunday) yy = Year (00–99) 

M = Month (1–12) yyyy = Year (1900–2040) 

sShortDate=format Specifies a choice for the short date format, including abbreviations for the 
words and separators, according to the list described for sLongDate=. 
Control Panel will accept only certain format combinations. Therefore, you 
should use Control Panel to change this setting. The default is M/d/yy (that 
is, 6/1/90). 

sThousand=string Specifies the symbol used to separate thousands. For example, if the value is 
a comma (,), the number appears as 3,000. The default is , (a comma). 

sTime=string Specifies the character used to separate the hours, minutes, and seconds in 
time. For example, if the value is a colon (:), the time appears as 15:29:31. 
The default is : (a colon). 
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[ports] Section 

This section lists the available communications and printer ports, defines default 
values, and lists files to which printer output can be sent. You can specify up to 
10 ports. This is similar to the mode command for MS-DOS. 

This section can contain one or more entries in this format: 

portname:=baud-rate, parity, word-length, stop-bits [[, p]] 

Value Meaning 

portname  The name of an output port as it is recognized by MS-DOS. This can be: 

 COMx:= for a communications port, where x represents the port number. 

 LPTx:= for a parallel port, where x represents the port number. 

 EPT:= for a specific IBM printer. 

 FILE:= for a filename. 

 LPTx.DOS= for a parallel port, where x represents the port number. 
Connecting to LPT2.DOS can bypass Windows handling or print output. 
Choose this option if you have trouble printing. 

baud-rate  Specifies a COM port’s baud rate. 

parity  Specifies the parity setting for a COM port. 

word-length  Specifies the length of a word (in bits) for a COM port. 

stop-bits  Specifies the number of stop bits to be used for a COM port. 

[[,p]]  Specifies that hardware handshaking is in effect. 
 

Values for LPT, EPT, FILE, and LPTx.DOS ports do not take any parameters. 

Specify a filename for the portname value to direct output to that file. A 
filename, unlike the other port names, must not be followed by a colon (:). If you 
specify a value for FILE:=, Windows will prompt you to specify an output file 
each time you print. 

To change COM port settings, choose the Ports icon from Control Panel. To 
change or add other ports, you must edit WIN.INI . 

LPT1.DOS=path 
LPT2.DOS=path 
LPT3.DOS=path 
LPT4.DOS=path 

Flowchart 4.2 
 Cannot Print 
on Network 

These settings are used (instead of the corresponding LPT ports) to specify the 
path of the printer you are using. This allows you to print directly to a parallel 
port. Use these settings to bypass Windows special handling for parallel port 
output. The default is none. To change this entry, you must edit WIN.INI . 
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[fonts] Section 

The [fonts] section describes the screen font files that Windows loads at startup. 
To change this entry, choose the Fonts icon from Control Panel. This section can 
contain one or more entries in this format: 

font-name=font-filename  

Value Meaning 

font-name  The descriptive name of a font.  

font-filename  The filename of a file that contains font resources.  
 

Note Adding entries to the [fonts] section will not install a font. You must 
choose the Fonts icon in Control Panel to install new fonts. 

[fontSubstitutes] Section 

The [fontSubstitutes] section describes fonts recognized by Windows as 
identical to another typeface. This is useful if you want to work on documents 
that include screen fonts that are not supported by Windows 3.1, but were 
supported by Windows 3.0.  

The [fontSubstitutes] section contains one or more occurrences of the following 
entry: 

 W font-name=font-name 

These entries specify the font that Windows will use in place of another font, 
only if that font is not installed on your system. For example, if you are viewing 
a document that is formatted in Helvetica, but Helvetica is not installed on your 
system, Windows will use Arial to display the document. To change this entry, 
you must edit WIN.INI . The default entries for this section are: 

[fontSubstitutes] 
Helv=MS Sans Serif 
Tms Rmn=MS Serif 
Times=Times New Roman 
Helvetica=Arial  
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[TrueType] Section 

The [TrueType] section describes options that affect the use and display of 
TrueType fonts in your Windows applications. The [TrueType] section can 
contain the following entries: 

 W OutlineThreshold=number-of-pels-per-em 

This entry specifies the number of pels-per-em at which Windows will render 
TrueType fonts as outline fonts instead of as bitmap fonts. Using bitmap fonts is 
faster, but requires more memory. If your system is low on memory, decrease 
this value. Do not specify a value over 300. If you do, you might encounter 
problems with TrueType fonts. The default is 256. To change this entry, you 
must edit WIN.INI . 

 W TTEnable=0 | 1 

This entry controls whether TrueType fonts are available. Setting this value to 
1 makes TrueType fonts available in your Windows applications. Setting this 
value to 0 turns off TrueType fonts so they are unavailable in applications. The 
default is 1. To change this entry, choose the Fonts icon from Control Panel. 

 W TTIfCollisions=0 | 1 

This entry specifies whether to use TrueType fonts in place of other fonts if both 
types of fonts are installed on your system and have the same font name. If this 
value is set to 1, the TrueType font will be used. For example, Windows 
provides both a bitmap and a TrueType version of the Symbol font. If you set 
this value to 0, Windows will use the TrueType version. The default is 0. To 
change this entry, you must edit WIN.INI . 

 W TTOnly=0 | 1 

This entry specifies whether to make only TrueType fonts available in Windows 
applications. If this value is set to 1, only TrueType fonts are available. If this 
value is set to 0, all fonts installed on your system are available. The default is 0. 
To change this entry, choose the Fonts icon from Control Panel. 
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[mci extensions] Section 

W The [mci extensions] section contains entries that associate different types 
of media files with Media Control Interface drivers. Whenever a media file 
is selected, Windows will use the associated driver to play it. This section can 
contain one or more occurrences of the following entry: 

extension=mcidevice-type 

[network] Section 

The [network] section describes network settings and previous network 
connections. The [network] section can contain the following entries: 

W drive=network-server-and-share 

This entry shows the network connections that are restored each time Windows 
is started. To change this entry, choose the Network Connections command from 
the Disk menu in File Manager. 

 W InRestoreNetConnect=0 | 1 

This entry specifies whether to reconnect to the network servers you were 
connected to in your previous Windows session. This setting works for MS-Net, 
LAN Manager Basic, and LAN Manager 2.0. If this value is set to 1, you will be 
reconnected to the network servers each time you start Windows. If this value 
is set to 0, you will not be reconnected. The default is 1. To change this entry, 
choose the Networks option from Control Panel, or if the Network dialog box 
for your network does not include a reconnect option, edit WIN.INI . 

  W port=network-printer-path 

This entry defines the path for a network printer and the port the printer is 
assigned to. This connection is restored each time Windows is started. To 
change this entry, choose the Printers option from Control Panel, or the Network 
Connections command from the Options menu in Print Manager. 
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[embedding] Section 

  W The [embedding] section lists the Object Linking and Embedding (OLE) 
objects, their description, the program that is used to create them, and their file 
format. This information also appears in the Registration Info Editor. We 
recommend that you use the Registration Info Editor to register applications or 
edit application information for OLE. The [embedding] section is included in 
WIN.INI  only to maintain compatibility with Windows 3.0 and 3.0 applications. 
The [embedding] section can contain one or more entries in the following 
format to specify the objects used as servers for OLE: 

object=description, description, program file, format 

Value Meaning 

object  Specifies the name of the server object.  

description  Provides a description of the server object. The second description appears in 
the list of registered file types in the Registration Info Editor.  

program file  Identifies the path and name of the executable file for the application that is 
used to create the object.  

format  Identifies the format of the file. The value for this entry is most often picture, 
which is the Windows Metafile format. To change this entry, use the 
Registration Info Editor. 

[Windows Help] Section 

The [Windows Help] section includes settings that specify the size and 
placement of the Help window and dialog boxes, as well as the color of text that, 
when chosen, displays a macro, pop-up window, or new panel. The [Windows 
Help] section can include the following entries: 

W M_WindowPosition=number,number, number,number,number 
H_WindowPosition=number,number, number,number,number 
A_WindowPosition=number,number, number,number,number 
C_WindowPosition=number,number, number,number,number 

These entries define the default size and position of the main Help window, and 
the History, Annotate, and Copy dialog boxes. The first and second number 
values define the x and y coordinates of the upper-left corner for the default 
position of the main Help window and the dialog boxes. The third and fourth 
number values define the default width and height (in pixels) of the Help win-
dow and dialog boxes. The fifth number specifies whether the main Help 
window is maximized, where 1 is maximized, and 0 is the default height and 
width of the window. Changing this value has no effect on the size of the dialog 
boxes, because they cannot be maximized. 

To change this entry, move or size the main Help window, or the History, 
Annotate, or Copy dialog boxes. The values are updated in WIN.INI  
automatically. 
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 W IFJumpColor=red-value green-value blue-value 

This entry specifies the color of text that, when chosen, leads to a new panel of 
information in another help file. To change this entry, you must edit WIN.INI . 

 W IFPopupColor=red-value green-value blue-value 

This entry specifies the color of text that, when chosen, displays a pop-up panel 
(the type of panel used for glossary definitions) located in a different help file. 
To change this entry, you must edit WIN.INI . 

JumpColor=red-value green-value blue-value 

This entry specifies the color of text that leads to a new panel of help 
information. For example, entering 000 000 000 as values results in black 
text on a white background. To change this entry, you must edit WIN.INI . 

 W MacroColor=red-value green-value blue-value 

This entry specifies the color of text that, when chosen, runs a Help macro. To 
change this entry, you must edit WIN.INI . 

 W PopupColor=red-value green-value blue-value 

This entry specifies the color of text that, when chosen, displays a pop-up panel 
(the type of panel used for glossary definitions). For example, entering 000 000 
000 as values results in black text on a white background. To change this entry, 
you must edit WIN.INI . 

[sound] Section 

The [sound] section lists the system events that support sound and the sound 
files that are assigned to each event. The [sound] section can contain one or 
more occurrences of the following entry: 

 W system event=filename,description 

This entry specifies the sound file assigned to and a description of a system 
event. The filename keyname is the name of the sound file. The description 
keyname is a text string that describes the system or application event. To 
change this entry, choose the Sound icon in Control Panel. 
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[printerPorts] Section 

The [printerPorts] section lists the active and inactive printers that can be 
accessed by Windows device drivers, specifies the communications port or ports 
to which the devices are connected, and specifies their corresponding timeout 
values. This section can contain one or more entries in this format: 

device=driver, port, DeviceTimeout, RetryTimeout [, other ports . . .] 

Value Meaning 

device  The name of the device.  

driver  The driver filename, with path if necessary. 

port  Specifies the port the device is connected to. If a device is not currently 
connected, the value is the NullPort= entry of the [Windows] section.  
There is a set of port, DeviceTimeout,and RetryTimeout values for each 
port that has a printer of the specified type. 

DeviceTimeout  Determines the number of seconds that Print Manager will wait for the 
device to be switched on. 

RetryTimeout  Determines the number of seconds before attempted transmission retries. 
This value might need to be increased for network printers. 
 

If the timeout values are not specified for a particular port, Windows uses the 
default values listed in the [Windows] section for that port. 

To change this entry, choose the Printers icon from Control Panel or choose 
Printer Setup from the Options menu in Print Manager, then choose Connect. 

Important    When changing an entry in this section, be sure it does not conflict 
with a corresponding entry in the [devices] section. Problems can occur if a 
connected device does not appear in the [printerPorts] section.  
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[devices] Section 

The [devices] section lists the active printers, and is necessary only for compat-
ibility with Windows version 2.x applications. The entries in this section are 
identical to those in the [printerPorts] section, without the timeout values. The 
[devices] section can contain one or more entries in this format: 

device=driver, port [, other ports . . . ] 

The values specified are identical to the first three items in the [printerPorts] 
section. To change this entry, choose the Printers icon from Control Panel. 

Important    When changing an entry in the [devices] section, be sure it does not 
conflict with a corresponding entry in the [printerPorts] section. Problems can 
occur if a connected device does not appear in the [printerPorts] section.  

[programs] Section 

The [programs] section identifies the paths, in addition to those in the 
AUTOEXEC.BAT file, that Windows will search to start an application. If you try 
to open a data file associated with an application, and Windows cannot find the 
program file needed to start the application, Windows will prompt you to supply 
the path for the program file. The path you specify is automatically added to the 
[programs] section of WIN.INI . Windows will search the path for the program 
file the next time you want to start an application by opening an associated data 
file. The [programs] section can contain one or more occurrences of the 
following entries to specify the drive, directory, and executable program file 
needed to start an application: 

 W program file=drive:directory\program file 

Value Meaning 

program file  Specifies the name of the program file that Windows was searching for when 
you tried to open the associated data file.  

drive  Specifies the drive on which the program file is located.  

directory  Specifies the directory in which the program file is located. The second 
program file keyname specifies the name of the executable program file, 
located in the specified drive and directory, needed to start the associated 
application. 
 

To change this entry, complete the dialog box in File Manager that prompts you 
for the path if you try to open an application that it can’t find. 
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[colors] Section 

The [colors] section defines the colors for components of the Windows display. 
To change these entries, choose the Color icon from Control Panel. This section 
can contain entries in this format: 

component=red-value green-value blue-value 

Value Meaning 

component  Any one of these keynames: 
 ActiveBorder (the border of the active window) 
 ActiveTitle (the title bar of the active window) 
 AppWorkspace (the application workspace for Windows applications) 
 Background (refers to the desktop) 
 ButtonFace  
 ButtonShadow  
 ButtonText  
 GrayText (text that is dimmed, as in an unavailable command name) 
 Hilight (the background of highlighted text) 
 HilightText (the highlighted text itself) 
 InactiveBorder (the border of an inactive window) 
 InactiveTitle (the title bar of an inactive window) 
 InactiveTitleText (text in an inactive title bar)  
 Menu (the background of menus) 
 MenuText  
 Scrollbar  
 TitleText (the text in the title bar) 
 Window (the workspace in a window)  
 WindowFrame  
 WindowText  

red-value  Integers that specify the relative intensities of the respective colors.  
blue-value These values can range from 0 (minimum intensity)  
green-value  to 255 (maximum intensity). 
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SYSTEM.INI:  The System Initialization File 

When you install Windows, Setup creates the SYSTEM.INI file, which contains 
global system information that Windows uses when it starts. The following 
sections can appear in SYSTEM.INI. 

Section Purpose 

[boot]  Lists drivers and Windows modules. 

[boot.description]  Lists the names of devices you can change using Windows Setup. 

[drivers]  Contains a list of aliases (or names) assigned to installable driver files. 

[keyboard]  Contains information about the keyboard. 

[mci]  Lists Media Control Interface (MCI) drivers. 

[NonWindowsApp]  Contains information used by non-Windows applications. 

[standard]  Contains information used by Windows in standard mode. 

[386enh]  Contains information used by Windows in 386 enhanced mode.  
 

Setup assigns a value to each entry in the [boot] and [keyboard] sections, and to 
the Device= entry and its synonyms in the [386enh] section. These entries must 
appear in SYSTEM.INI for Windows to function properly. These entries do not 
have built-in values, but have specific values that Setup assigns when you install 
Windows. 

Many of the other entries described in this chapter are rarely needed and will not 
appear in the SYSTEM.INI file unless you add them yourself. Most of these 
entries have built-in values that are present whether the entry appears in 
SYSTEM.INI. You might need to change one or more of these values to improve 
the performance of Windows or of a specific application.  

The possible methods for changing values are noted for each entry in this 
chapter. You cannot change most SYSTEM.INI entries through Control 
Panel, but you can change many settings by running Setup. Other values in 
SYSTEM.INI can be changed only by opening the file and editing it with a text 
editor such as Notepad.  

Any changes you make to the SYSTEM.INI file do not take effect until you restart 
Windows.  

Important    Always back up the SYSTEM.INI file before you open it. Use 
extreme care when making changes with a text editor, because you can disable 
your system if you edit the file incorrectly. If the entry can be changed without 
editing SYSTEM.INI, use that recommended method. 

This section describes the contents of the SYSTEM.INI file and how to change 
values for entries in the file. 
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[boot] Section 

The [boot] section contains a list of the drivers and Windows modules that 
Windows uses to configure itself each time you start it. 

Important    All entries in this section are required. If you modify or delete one 
of these entries, Windows might not start or operate properly. Setup assigns all 
values based on your system configuration; there are no built-in values for these 
entries. 

The [boot] section can contain the following entries: 

286grabber=filename 

This entry specifies the filename of the grabber, which is the device driver  that 
makes a non-Windows application visible when you run Windows in standard 
mode. The default is none (blank). To change this entry, choose the Windows 
Setup icon from the Main Group window and change the Display setting. If you 
are installing a device driver that is not included with Windows, exit Windows 
and run Setup from MS-DOS. 

386grabber=filename 

This entry specifies the filename of the grabber, which is the device driver that 
makes a non-Windows application visible when you run Windows in 386 
enhanced mode. The default is none (blank). To change this entry, choose the 
Windows Setup icon from the Main Group window and change the Display 
setting. If you are installing a device driver that is not included with Windows, 
exit Windows and run Setup from MS-DOS. 

 W CachedFileHandles=number 

This entry specifies the number of the most recently-used executable files (.EXE) 
and dynamic-link library files (.DLL) that can remain open. Windows keeps 
these files open so that they can be accessed quickly, ensuring optimal 
performance. However, some networks have a limit on the number of files that 
can be open on a server at a time. If you have problems running Windows from a 
network server, use a lower number for this value. Valid numbers are 2 through 
12. The default is 12. To change this entry, you must edit SYSTEM.INI.  

comm.drv=filename 

This entry specifies the filename of the serial communications driver you are 
using. The default is none (blank). To change this entry, you must edit 
SYSTEM.INI. 
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display.drv=filename 

This entry specifies the filename of the display driver you are using. The default 
is none (blank). To change this entry, choose the Windows Setup icon from the 
Main Group window. If you are installing a device driver that is not included 
with Windows, exit Windows and run Setup from MS-DOS. 

 W drivers=filename | aliasname 

This entry specifies the filenames or aliases of the installable drivers that load 
when Windows is started. An installable driver is a dynamic-link library that 
Windows treats like a device driver. If the drivers you want to use include 
parameters, you must specify them by alias name as defined in the [drivers] 
section of SYSTEM.INI, where you can list several filenames or aliases. The 
default is none (blank). Most Setup programs for Windows applications add 
these settings to the SYSTEM.INI file when installing drivers, so you shouldn’t 
need to change the values. To change this entry, you must edit SYSTEM.INI.  

fixedfon.fon=filename 

This entry specifies the filename of the fixed system font used by Windows 
version 2.x applications. The default is none (blank). To change this entry, 
choose the Windows Setup icon from the Main Group window. This entry also 
changes when you change the Display setting in Setup.  

fonts.fon=filename 

This entry specifies the filename of the proportionately spaced system font used 
by Windows 3.1. The default is none (blank). To change this entry, choose the 
Windows Setup icon from the Main Group window. This entry also changes 
when you change the Display setting in Setup.  

keyboard.drv=filename 

This entry specifies the filename of the keyboard driver you are using. The 
default is none (blank). To change this entry, choose the Windows Setup icon 
from the Main Group window and change the setting for the Keyboard option. 

language.dll=library-name 

This entry specifies the name of the dynamic-link library that supplies language-
specific functions. If no language library is specified, Windows uses the built-in 
U.S. English library. The default is none (blank). To change this entry, choose 
the International icon from Control Panel and change the setting for the 
Language option. 
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mouse.drv=filename 

This entry specifies the filename of the mouse driver you are using. The default 
is none (blank). To change this entry, choose the Windows Setup icon from the 
Main Group window and change the setting for the Mouse option. 

network.drv=filename 

This entry specifies the filename of the network driver you are using. The default 
is none (blank). To change this entry, choose the Windows Setup icon from the 
Main Group window and change the setting for the Network option. 

oemfonts.fon=filename 

This entry supplies the name of the font file for the OEM character set, which is 
associated with the Display setting. The default is none (blank). To change this 
entry, exit Windows and run Setup from MS-DOS. This entry also changes when 
you change the Codepage or Display setting in Setup. 

shell=filename 

This entry specifies the Windows shell program that runs when you start 
Windows. Unless you change this entry, Program Manager will run when 
you start Windows. The default is none (blank). Setup initializes this value 
as progman.exe. To change this entry, you must edit SYSTEM.INI. 

sound.drv=filename 

This entry specifies the filename of the system sound driver you are using. The 
default is none (blank). To change this entry, you must edit SYSTEM.INI. 

system.drv=filename 

This entry specifies the filename of the system hardware driver you are using. 
The default is none (blank). To change this entry, exit Windows and run Setup 
from MS-DOS, then choose a new System setting. 

 W TaskMan.Exe=filename 

This entry specifies the task-switching application that appears when you press 
CTRL+ESC. The default is taskman.exe. To change this entry, you must edit 
SYSTEM.INI. 
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[boot.description] Section 

The [boot.description] section is a list of strings used to describe the devices 
you can change when you run Setup. There is no reason to change these entries. 
If you do change values, you cannot use Windows Setup to update drivers to 
newer versions. 

[drivers] Section 

 W This section contains a list of aliases (or names) assigned to installable driver 
files. The [drivers] section can contain this entry: 

alias=driver filename[parameters]  

This entry assigns an alias name to an installable driver and specifies any 
parameters used by the driver. This entry is associated with the drivers= entry in 
the [boot] section of SYSTEM.INI. If the driver includes parameters, you must 
assign an alias to it and then specify the driver by alias name in the [boot] 
section. You can define multiple aliases by specifying multiple alias lines in this 
entry. The default is none. Most Setup programs for Windows applications add 
these settings to SYSTEM.INI when installing drivers, so you shouldn’t need to 
change the values. To change this entry, choose the Drivers icon in Control 
Panel or use the installation program provided by the manufacturer.  

[keyboard] Section 

The [keyboard] section provides information about the keyboard. 

Important    All entries in this section are required. If you modify or delete 
one of these entries, Windows will not operate properly. There are no built-in 
default values for these entries; Setup assigns values based on the system 
configuration. 

The [keyboard] section can contain the following entries: 

keyboard.dll=filename 

This entry specifies the name of a dynamic-link library that defines the layout for 
non-U.S. keyboards and keyboards not compatible with IBM -compatible 
systems. This entry is required for all keyboards except these U.S. keyboards:  
IBM XT, PC/AT, or enhanced; AT&T  type 301 or 302; and Olivetti 83-key. To 
change this entry, choose the Windows Setup icon from the Main Group window 
or the International icon from Control Panel. 
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oemansi.bin=filename 

This entry specifies the name of a file that defines OEM/ANSI code-page 
translation tables for systems not using code page 437 (the U.S. OEM character 
set). To change this entry, exit Windows and run Setup from MS-DOS. This 
setting also changes when you change the Codepage or Display settings. 

subtype=number 

This entry distinguishes, for some drivers, special features for keyboards that 
otherwise have identical layouts. This value can also be used by other drivers. 
To change the subtype= entry, choose the Windows Setup icon from the Main 
Group window. See the type= entry for information about type values. These 
values are defined for subtype=. 

Type Subtype 
value value Meaning 

1 2 Olivetti M24 83-key or AT&T 6300 type 301 83-key. 

1 4 AT&T type 302 sometimes used on the 6300 Plus. 

2 1 Olivetti 102-key ICO used on M24 systems.  

 
 

type=number 

This entry specifies the keyboard type. It can be any one of these values. 

Value  Meaning 

1 IBM PC or XT compatible (83 keys) 

2 Olivetti 102-key ICO 

3 IBM AT compatible (84 or 86 keys) 

4 IBM compatible, enhanced (101 or 102 keys) 
 

If this entry is blank or missing, the driver selects a default type. For IBM -
compatible keyboards (using the KEYBOARD.DRV driver), the default type is 
determined by the BIOS. To change this entry, choose the Windows Setup icon 
from the Main Group window. 
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[mci] Section 

W The [mci] section contains a list of the drivers that use the Media Control 
Interface (MCI) to play media files. These drivers are installed automatically 
when you run Setup. To change these values, choose the Drivers icon in Control 
Panel. 

[NonWindowsApp] Section 

The [NonWindowsApp] section contains entries that affect the performance of 
non-Windows applications. This section can contain the following entries: 

W CommandEnvSize=bytes 

This entry specifies the size of the COMMAND.COM environment. Since running 
batch files with the extension .BAT starts COMMAND.COM, this setting also 
applies to batch files. The value for this setting must be either 0 or between 160 
and 32768. A value of 0 disables this setting. If the value is not valid, it will be 
rounded up to 160 or down to 32768. If the value is less than the current size of 
the actual environment, this setting will be disabled, as if it were set to 0. If you 
specified the environment size in a PIF for COMMAND.COM, the PIF setting 
overrides this setting.  The default is 0 with MS-DOS versions earlier than 3.2. 
Otherwise, the value is the /e: parameter in the shell= line in CONFIG.SYS.  To 
change this value, you must edit SYSTEM.INI. 

 W DisablePositionSave=Boolean 

When this entry is 0, the position and font used in a non-Windows application is 
saved in the DOSAPP.INI file when you quit the application. If this entry is 1, any 
settings that weren’t saved previously in DOSAPP.INI will not be saved. If this 
entry is 1, the setting can be overridden for each non-Windows application by 
selecting the Save Settings On Exit checkbox in the Fonts dialog box. The 
default is 0. To change this entry, you must edit SYSTEM.INI.  

 W FontChangeEnable=Boolean 

This entry, if 1, provides the ability to change the fonts when running non-
Windows  applications in a window on systems that use version 3.0 of the 
grabbers (usually in version 3.0 display drivers). Windows version 3.1 of the 
video grabbers (used in version 3.1 display drivers) include built-in support for 
changing fonts when running non-Windows applications in a window. If you are 
using a 3.0 grabber that has not been updated to include the ability to change 
fonts and you want to use this feature, set this value to 1. However, when this 
entry is 1, your screen may lose characters and the cursor may change size and 
position slightly.  The default is 1 on systems that use Windows 3.1 grabbers, 
and 0 on systems that use Windows 3.0 grabbers. To change this entry, you must 
edit SYSTEM.INI. 
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 W GlobalHeapSize=kilobytes 

This entry specifies the size of a buffer in conventional memory that Windows 
allocates when running in standard mode. This buffer can be used to share 
information among all non-Windows applications that are started from 
Windows. This setting has no effect when Windows is running in 386 enhanced 
mode. The default is 0. To change this entry, you must edit SYSTEM.INI. (You 
should never need to change this setting.) 

W LocalTSRs=list-of-TSR-applications 

This entry specifies which terminate-and-stay-resident (TSR) programs work 
properly if they are copied to each instance of a virtual machine. When you start 
Windows, it detects any TSR programs that are currently running. If the TSR is 
on the LocalTSRs= list, Windows will place a copy of the TSR in each virtual 
machine you run. Many TSRs will not run properly if they are added to this list. 
Make sure your TSR is fully compatible with Windows and can be copied to a 
virtual machine before adding it to the list. The default is dosedit, pced, ced. To 
change this value, you must edit SYSTEM.INI. 

 W MouseInDosBox=Boolean 

This entry specifies whether the mouse is supported when running a non-
Windows application in a window. Mouse support for non-Windows appli-
cations running in a window is available automatically if you are using a 
Windows 3.1 version of the grabbers. If you are using a Windows 3.0 version 
of the grabbers and you want mouse support, enable this setting. If you do not 
want mouse support, disable this setting.  The default is 1 if an MS-DOS mouse 
driver is loaded that has the extension .COM or .SYS and that supports using a 
mouse with a non-Windows application. Otherwise, the default is 0. To change 
this entry, you must edit SYSTEM.INI.  

NetAsynchSwitching=0 | 1 

This entry indicates whether you can switch away from an application running in 
Windows standard mode after it has made an asynchronous network BIOS call. 
The default value of 0 specifies that such task switching is not possible. 
Switching away from some applications that make these calls might cause the 
system to fail. Once Windows detects an asynchronous NetBIOS call, it will not 
allow switching away from the application even if no more of these calls are 
made. Set this value to 1 if you are sure the applications you use will not receive 
network messages while you are switched away from them. To change this entry, 
you must edit SYSTEM.INI. 
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ScreenLines=number 

This entry specifies the number of lines displayed on the screen when a non-
Windows application runs. An application that specifies a different screen mode 
can override this entry. The default is 25. To change this entry, you must edit 
SYSTEM.INI. 

SwapDisk=drive:directory 

This entry provides the name of the disk drive and directory to which Windows 
standard mode swaps non-Windows applications. The default is the directory 
pointed to by the TEMP environment variable; if there is no TEMP variable, then 
the default is the boot directory of your first hard disk (usually C:).  If your 
system does not have a hard disk, the default is the root directory on the first 
floppy drive (usually A:). To change this entry, you must edit SYSTEM.INI. 

[standard] Section 

The [standard] section contains entries that are specific to running Windows in 
standard mode. This section can contain the following entries: 

 W FasterModeSwitch=0 | 1 

This entry, if set to 1, causes Windows standard mode to use a faster method of 
switching from protected to real mode on many 80286-based computers. When 
this entry is 1, Windows responds more quickly to hardware interrupts, allowing 
better throughput for interrupt-intensive applications, such as communications 
applications. Also, you should set this entry to 1 if you are using a Zenith Z-248 
system and are losing characters while typing, or if you are using an Olivetti M-
250-E and lose control of the mouse. The default is 0. To change this entry, you 
must edit SYSTEM.INI. 

Note The value for FasterModeSwitch= has no effect on 80386-based 
computers. Some early IBM-AT  and compatible computers do not have the BIOS 
support necessary to use this setting. Setting this entry to 1 on these computers 
may cause them to hang when starting Windows. 

Int28Filter=number 

This entry specifies the percentage of INT 28h interrupts, generated when the 
system is idle, that are visible to software loaded before Windows. Windows will 
reflect every nth interrupt, where n is the value of this entry. For example, a 
value of 1 reflects every INT 28h interrupt, a value of 2 reflects every second 
INT 28h interrupt, a value of 3 reflects every third INT 28h interrupt, and so on. 
Increasing this value might improve Windows performance, but may interfere 
with some memory-resident software such as a network.  
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Set this value to 0 to prevent INT 28h interrupts. But setting this value too 
low adds to system overhead that might interfere with communications 
applications. The default is 10. To change this entry, you must edit SYSTEM.INI. 

W MouseSyncTime=milliseconds 

This entry specifies the number of milliseconds that can elapse between mouse 
data bytes before Windows running in standard mode assumes that a mouse data 
packet is complete. This setting only affects Windows standard mode on 
computers with an IBM PS/2 mouse interface. The default is 500. To change this 
value, you must edit SYSTEM.INI. 

NetHeapSize=kilobytes 

This entry specifies the size of the data-transfer buffers that Windows standard 
mode allocates in conventional memory for transferring data over a network. 
If an application is not running correctly, your network may require a larger 
buffer than the default. Increasing this value will decrease the amount of 
memory available to applications. If no network software is running, this entry is 
ignored and no memory is allocated. The default is 8. To change this entry, you 
must edit SYSTEM.INI. 

PadCodeSegments=0 | 1 

Setting the value of this entry to 1 causes Windows Kernel to pad code segments 
with 16 bytes. This prevents the last instruction in the segment from being too 
close to the segment limit for 80286 C2 stepping. Set this value to 1 only for this 
80286 stepping. Unfortunately, there is no easy way of telling what stepping a 
80286 chip is. Try setting this value to 1 if your 80286 system hangs in standard 
mode. The default is 0. To change this entry, you must edit SYSTEM.INI. 

 W Stacks=number  

This entry specifies the number of interrupt reflector stacks used by the standard 
mode MS-DOS Extender (DOSX) to map an MS-DOS or BIOS API from real 
mode to protected mode. If you receive a “Standard Mode: Stack Overflow” 
message, try increasing this number. You can specify a number between 8 and 
64. The default is 12. To change this entry, you must edit SYSTEM.INI. 

 W StackSize=kilobytes  

This entry specifies the size of the interrupt reflector stacks used by the standard 
mode MS-DOS Extender. The default is 384. To change this entry, you must edit 
SYSTEM.INI. (You should never need to change this entry.) 
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[386enh] Section 

The [386enh] section contains information specific to running Windows in 386 
enhanced mode, including information used for virtual-memory page swapping.  

For entries in this section that specify virtual devices, the value can appear in 
two ways:  either the filename of a specific virtual device driver (with path if 
necessary), or as an asterisk (*) followed immediately by the device name to 
refer to a virtual device built into the WIN386.EXE file.  

This section can contain the following entries: 

W 32BitDiskAccess=Boolean 

This entry turns 32-bit disk access on or off.  The default is Off if your hard disk 
is capable of supporting 32-bit disk access. Otherwise, this setting is not present 
in SYSTEM.INI. To change this entry, choose the 386 Enhanced icon in Control 
Panel. If this setting is not present in SYSTEM.INI, the 32-Bit Disk Access check 
box will not appear in Control Panel Virtual Memory dialog box. 

 W A20EnableCount=number 

This entry specifies the initial A20 enable count, which identifies the A20 
handler that HIMEM.SYS uses to access extended memory. (For more 
information about the A20 enable count, see the documentation for your 
extended memory manager.) The default is the value computed by the Win386 
loader. To change this entry, you must edit SYSTEM.INI. (You should never 
need to change this entry.) 

W AllEMSLocked=Boolean  

This entry, if On, locks the contents of expanded memory used by all Windows 
and non-Windows applications into memory (instead of swapping it to disk) and 
overrides PIF settings for EMS Memory Locked. Set this value to On if you are 
using a disk cache program that uses expanded memory. The default is Off. To 
change this entry, you must edit SYSTEM.INI. 

AllVMsExclusive=Boolean 

This entry, when On, forces all applications to run in exclusive full-screen 
mode, overriding all other settings in the application PIFs. Setting 
AllVMsExclusive=on might help avoid UAEs when you are running network or  
memory-resident software that is not compatible with Windows. The default is 
Off. To change this entry, you must edit SYSTEM.INI. 
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W AllXMSLocked=Boolean  

This entry, if On, locks the contents of the extended memory used by all 
Windows and non-Windows applications into memory (instead of swapping it to 
disk), and overrides PIF settings for XMS Memory Locked. The default is Off. 
To change this entry, you must edit SYSTEM.INI. (You should never need to 
change this entry). 

AltKeyDelay=seconds 

This entry specifies how much time Windows waits to process a keyboard 
interrupt after it processes an ALT interrupt. Some applications expect a slower 
processing rate than Windows 386 enhanced mode usually uses. Increase this 
value if such an application has trouble handling the ALT key. The default is 
.005. To change this entry, you must edit SYSTEM.INI. 

AltPasteDelay=seconds 

This entry specifies how much time Windows waits before pasting any 
characters after the ALT key has been pasted. Some applications may require 
more time for recognition of the ALT keystroke. The default is .025. To change 
this entry, you must edit SYSTEM.INI. 

   W AutoRestoreScreen=Boolean 

This entry specifies whether the display for non-Windows applications should be 
restored by Windows or by the applications themselves when they become 
active. If this entry is On, Windows saves the display information for a non-
Windows application in memory when you switch away from the application. 
When you switch back to the application, Windows restores the screen. If this 
entry is Off, the application must restore its own display by repainting the 
screen. This requires less memory, but can slow down performance since 
Windows can usually restore the screen faster. This entry only applies to VGA 
displays and affects only applications that notify Windows that they can update 
their screens automatically when Windows sends a display update call. The 
default is On. To change this entry, you must edit SYSTEM.INI. 

 W BkGndNotifyAtPFault=Boolean 

This entry specifies when a notification should be sent to a non-Windows 
application or to Windows to prevent the application from attempting to access 
the display (which might corrupt the display of a different application). This 
notification can be sent while switching to a different application or when 
attempting to access the actual display. If this entry is Off, Windows sends a 
notification when switching between applications. Set this entry to Off if you are 
using a display that has special hardware (for example, 8514 and TIGA). If you 
are using a VGA display, setting this entry to On should work in most cases. The 
default is On for VGA displays; Off for 8514 displays. To change this entry, you 
must edit SYSTEM.INI. 
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CGA40WOA.FON=filename 

This entry specifies the filename of the fixed-pitch display font used for non-
Windows applications with a display of 40 columns and 25 or fewer lines. The 
default is none. To change this entry, exit Windows and run Setup from MS-
DOS, then change the Codepage or Display setting. 

CGA80WOA.FON=filename 

This entry specifies the filename of the fixed-pitch display font used for non-
Windows applications with a display of 80 columns and 25 or fewer lines. The 
default is none (blank). To change this entry, exit Windows and run Setup from 
MS-DOS, then change the Codepage or Display setting. 

CGANoSnow=Boolean 

This entry, when On, causes Windows to do special handling to avoid snow 
appearing on an IBM  CGA display device. The default is Off. To change this 
entry, you must edit SYSTEM.INI. 

COM1AutoAssign=number | seconds 
COM2AutoAssign=number | seconds 
COM3AutoAssign=number | seconds 
COM4AutoAssign=number | seconds 

These entries indicate the contention detection values for each connected 
communications port. These values are used by Windows to determine how to 
arbitrate requests for the use of a device by more than one application, at least 
one of which is a non-Windows application. If the value is -1, Windows will 
display a warning message that asks you which application should be given 
control of the port. If the value is 0, any application can use the device at any 
time. If the value is a positive integer less than 1000, this value represents the 
number of seconds after an application stops using the device before another 
application can use the same device. The default is 2. To change this entry, 
choose the 386 Enhanced icon from Control Panel. 

COM1Base=address 
COM2Base=address 
COM3Base=address 
COM4Base=address 

Flowchart 2.2 
 Serial Port Problems  

These entries specify the base (first) port for the serial port adapter you are using 
for both standard mode and 386 enhanced mode. Check your hardware 
documentation for the appropriate value. The defaults are COM3Base=3E8h, 
and the port address values in the BIOS data area for COM1, COM2, and COM4. 
To change this entry, choose the Ports icon in Control Panel, and click the 
Advanced button for the selected COM port. 
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COMBoostTime=milliseconds 

This entry specifies the time to allow a virtual machine to process a COM 
interrupt. If a communications application is losing keyboard characters on the 
display, you can try increasing this value. The default is 2. To change this entry, 
you must edit SYSTEM.INI. 

COM1Buffer=number 
COM2Buffer=number 
COM3Buffer=number 
COM4Buffer=number 

These entries specify the number of characters that the device will buffer on 
the corresponding communications port. Before changing one of these entries, 
make sure the corresponding COMxProtocol= entry has the proper value. 
Buffering may slow down communications on a port, but might be necessary to 
prevent some communications applications from losing characters at high baud 
rates. The size of the buffer required will depend on the speed of the machine 
and the application’s needs. The default is 128. Before increasing this value, see 
COMxProtocol=. To change this entry, you must edit SYSTEM.INI. 

 W COMdrv30=Boolean 

This entry, if On, indicates that the Virtual COM Driver (VCD) will use its own 
copy of the serial communications driver’s interrupt handler. This will improve 
performance of COM ports. Set this entry to On if you are using a Windows 3.0 
serial communications driver. Set this entry to Off if you are using the standard 
Windows 3.1 serial communications driver. The default is Off. To change this 
entry, you must edit SYSTEM.INI. 

 W COM1FIFO=Boolean 
COM2FIFO=Boolean 
COM3FIFO=Boolean 
COM4FIFO=Boolean 

These entries specify whether the FIFO buffer of a COM port’s 16550 Universal 
Asynchronous Receiver Transmitter (UART) should be enabled (On) or disabled 
(Off). If a serial port does not have a 16550 UART, this setting is ignored. These 
values are used by Windows for both standard and enhanced modes. The default 
is On. 
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COM1Irq=number 
COM2Irq=number 
COM3Irq=number 
COM4Irq=number 

These entries specify which interrupt line is used by the device on the speci-
fied serial port. Check your hardware documentation for the correct value. 
If there is a hardware conflict between ports, set a value of -1 to disable input 
for that COM port. The defaults for ISA and EISA machines are COM1Irq=4, 
COM2Irq=3, COM3Irq=4, and COM4Irq=3; for MCA machines, the defaults 
are COM1Irq=4, COM2Irq=3, COM3Irq=3, and COM4Irq=3. To change 
this entry, choose the Ports icon in Control Panel and click the Advanced button. 

COMIrqSharing=Boolean 

This entry specifies whether COM interrupt lines will be sharable between 
mulitiple serial ports or with other devices. Set this switch if your machine uses 
the same interrupt for COM3 or COM4 as it does for COM1 or COM2. The default 
is On for Micro Channel and EISA machines; Off for all other machines. To 
change this entry, you must edit SYSTEM.INI. 

COM1Protocol=XOFF | blank 
COM2Protocol=XOFF | blank 
COM3Protocol=XOFF | blank 
COM4Protocol=XOFF | blank 

These entries specify whether Windows 386 enhanced mode should stop 
simulating characters in a virtual machine after the virtual machine sends an 
XOFF character. Set the value for a port to XOFF if a communications 
application using that port is losing characters while doing text transfers at high 
baud rates. Windows will resume simulating characters when the virtual machine 
sends another character after the XOFF character.  

Leave this entry blank if the application does binary data transfers; setting this 
switch might suspend binary transmissions. The default is no entry, which is the 
same as any entry other than XOFF. Windows will not check for XOFF 
characters if this entry is blank or set to anything other than XOFF. If the 
application continues to lose characters after this entry is set, try increasing the 
related COMxBuffer= value. To change this entry, you must edit SYSTEM.INI. 

Device=filename | *devicename 

This entry specifies which virtual devices are being used with Windows 386 
enhanced mode. This value can appear in two ways:  either the name of a speci-
fic virtual device file (with path if necessary), or an asterisk (*) followed imme-
diately by the device name to refer to a virtual device built into the WIN386.EXE 
file. Synonyms for Device= are Display=, EBIOS=, Keyboard=, Network=, 
and Mouse=. Filenames usually include the .386 extension. Multiple device 
lines are required to run Windows 386 enhanced mode. The default is none. 
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Setup assigns appropriate values based on your system configuration. To change 
this entry, you must edit SYSTEM.INI. 

W If Setup detects protected mode block devices for Western Digital–compatible 
controllers, it adds the entries device=*int13 and device=*wdctrl to [386enh]. 
A block device is a virtual device used in 386 enhanced mode to talk directly to 
disk drive controllers, bypassing MS-DOS and BIOS. To remove block device 
support, delete these entries  in SYSTEM.INI. You do not need to delete files 
from your hard disk, as these devices are appended to WIN386.EXE. 

Display=filename | *devicename 

This entry specifies the display device being used with Windows 386 enhanced 
mode. This entry is a synonym for Device=. The default is none. Setup assigns 
an appropriate value based on your system configuration. To change this entry, 
choose the Windows Setup icon from the Main Group window. 

DMABufferIn1MB=Boolean 

This entry, if set to On, indicates that the direct memory access (DMA) buffer 
memory should be in the first 1 MB of memory (above 640K, if possible) to be 
compatible with 8-bit bus master cards. The default is Off. To change this entry, 
you must edit SYSTEM.INI. 

DMABufferSize=kilobytes 

This entry specifies the amount of memory to be reserved for the DMA  buffer. 
This memory will be allocated above 640K, if possible. Windows 386 enhanced 
mode will default to a DMA  buffer size that will handle disk access. The default 
is 16. To change this entry, you must edit SYSTEM.INI. 

 W DOSPromptExitInstruc=Boolean 

This entry, if On, causes a message box to appear when you start the MS-DOS 
Prompt, displaying instructions on how to exit and switch away from the MS-
DOS Prompt. Set this entry to Off if you do not want to see the message. The 
default is On. To change this entry, you must edit SYSTEM.INI. 

DualDisplay=Boolean 

Usually, when Windows is running in 386 enhanced mode, the memory between 
B000:0000 and B7FF:000F will be used by the general system unless a 
secondary display is detected. If this entry is On, this memory will be left 
unused and available for display adapters, or if you do not have a monochrome 
display card installed and want EMM386.EXE to include this address space as an 
upper memory block (UMB). If this entry is Off, the address range will be 
available on EGA systems but not under VGA systems, because the VGA display 
device supports monochrome modes, which use this address space. To change 
this entry, you must edit SYSTEM.INI. 
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EBIOS=filename | *devicename 

This entry specifies the extended BIOS device being used with Windows 386 
enhanced mode. This entry is a synonym for Device=. The default is the value 
that Setup assigns, based on your system configuration. To change this entry, 
you must edit SYSTEM.INI. 

EGA40WOA.FON=filename 

This entry specifies the filename of the fixed-pitch display font used for non-
Windows applications with a display of 40 columns and more than 25 lines. The 
default is none. To change this entry, exit Windows and run Setup from MS-
DOS, then change the Codepage or Display setting. 

EGA80WOA.FON=filename 

This entry specifies the filename of the fixed-pitch display font used for non-
Windows applications with a display of 80 columns and more than 25 lines. The 
default is none. To change this entry, exit Windows and run Setup from MS-
DOS, then change the Codepage or Display setting. 

EISADMA=Boolean | channel,size 

This entry specifies the mode of operation of an extended DMA  channel for 
Extended Industry Standard Architecture (EISA) machines only. This entry’s 
value can take one of two forms. If you set this entry to Off, Windows treats the 
machine as non-EISA, avoiding all EISA-related logic. Set this value to Off if 
you cannot run Windows 386 enhanced mode on an EISA machine. If you are 
using an EISA machine, you can specify the default transfer size for one or more 
DMA  channels. The channels can operate in these modes:  8-bit (8), 16-bit 
specified in words (16w), 16-bit specified in bytes (16b), or 32-bit (32). If you 
are not using an EISA machine, Windows ignores this entry. The default is 0,8;  
1,8;  2,8;  3,8;  5,16w;  6,16w;  7,16w. Each pair goes with its own EISADMA= 
entry. To change this entry, you must edit SYSTEM.INI. 

EMMExclude=paragraph-range 

Flowchart Series 5 
Windows Operation 

and Memory Problems 

This entry specifies a range of memory that Windows will not scan to find 
unused address space. This has the side effect of turning off the RAM and 
ROM search code for the range. The range (two paragraph values separated by a 
hyphen) must be between  A000 and EFFF. This scanning can interfere with 
some adapters that use the same memory area. The starting value is rounded 
down and the ending value is rounded up to a multiple of 16K. For example, you 
could set EMMExclude=C800-CFFF to prevent Windows from scanning the 
addresses C800:0000 through CFFF:000F (the block that some VGA cards use to 
enhance performance). You can specify more than one range by including more 
than one EMMExclude= entry. The default is none. To change this entry, you 
must edit SYSTEM.INI. 
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EMMInclude=paragraph-range 

This entry specifies a range of memory that Windows will scan for unused 
address space regardless of what may be there. EMMInclude= takes precedence 
over EMMExclude= if you specify ranges that overlap. The range (two values 
separated by a hyphen) must be between A000 and EFFF. The starting value is 
rounded down and the ending value is rounded up to a multiple of 16K. For 
example, you could set EMMInclude=C800-CFFF to ensure that Windows 
scans the addresses C800:0000 through CFFF:000F. You can specify more than 
one range by including more than one EMMInclude= entry. The default is 
none. To change this entry, you must edit SYSTEM.INI. 

EMMPageFrame=paragraph 

This entry specifies the starting paragraph where the 64K page frame will begin 
when Windows cannot find a suitable page frame, allowing an EMS page frame 
in an area containing some unused RAM or ROM. For example, you could set 
EMMPageFrame=C400 to start the page frame at C400:0000. The default is 
none. To change this entry, you must edit SYSTEM.INI. 

EMMSize=kilobytes 

This entry specifies the total amount of memory to be made available for 
mapping as expanded memory. The default allocates the maximum possible 
amount of system memory as expanded memory. Specify a value for this entry if 
you run an application that allocates all of the available expanded memory. This 
will be apparent if, when you run the application, you can never create any new 
virtual machine. If this value is 0, then no expanded memory will be allocated. 
This entry does not prevent the EMS driver from being loaded; use 
NoEMMDriver=on to turn off EMS. The default is 65,536. To change this 
entry, you must edit SYSTEM.INI. 

FileSysChange=Boolean 

This entry indicates whether File Manager automatically receives messages 
anytime a non-Windows application creates, renames, or deletes a file. When 
this entry is Off, a virtual machine can be run exclusively even when it modifies 
files. Setting this entry to On can slow down system performance significantly. 
The default is On for 386 enhanced mode; Off in standard mode. To change this 
entry, you must edit SYSTEM.INI. 
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Global=device-name 

This entry defines MS-DOS devices loaded in CONFIG.SYS that need to be 
global to the system.  The default is that all devices loaded in CONFIG.SYS are 
global to the system. But certain virtual devices might specify that an MS-DOS 
device be local (for example, MS$MOUSE). Use this entry to override that local 
specification. The device-name value must exactly match the case of the device 
name in CONFIG.SYS, or this entry will not work. Most device names are in all 
capital letters, so this value must usually be in all caps. To change this entry, you 
must edit SYSTEM.INI. 

 W HardDiskDMABuffer=kilobytes  

This entry specifies the amount of memory used for the Direct Memory Access 
(DMA) buffer. If you are using SMARTDrive and double buffering is turned on, 
this amount is determined automatically. You may need to change this value if 
you are using a hard disk that supports DMA  and are not using SMARTDrive, or 
if you do not have double buffering turned on. The default is 0 for AT architec-
ture computers; 64 for Micro Channel computers or computers that use DMA  
channel 3 (unless you use SMARTDrive with double buffering, in which case the 
default is 0). To change this entry, you must edit SYSTEM.INI.  

 W IdleVMWakeUpTime=seconds 

This entry causes timer interrupts to periodically “wake up” idle virtual 
machines after the specified number of seconds has elapsed. If a virtual machine 
does not use timer interrupts (INT 8 or INT 1Ch), Windows will not usually force 
timer interrupts into a virtual machine unless it is active. This entry forces the 
timer interrupts to occur. The value for this entry is rounded down to the lowest 
power of 2 (for example, 1, 2, 4, 8, 16, 32, 64). The default is 8. To change this 
entry, you must edit SYSTEM.INI. 

IgnoreInstalledEMM=Boolean 

This entry, if set to On, allows Windows to start in 386 enhanced mode even 
when there is an unknown expanded memory manager (EMM) running. Starting 
Windows with an unknown EMM running can cause the system to fail if 
memory-resident software was using expanded memory before Windows started. 
Set this entry only if no such software is installed or you are sure it will not be 
active when you run Windows. This entry applies only to EMMs servicing 
physical EMS hardware; Windows will not disable unrecognized 80386 
expanded memory emulators. The default is Off. To change this entry, you must 
edit SYSTEM.INI. 
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InDOSPolling=Boolean 

This entry, if set to On, prevents Windows from running other applications when 
memory-resident software has the InDOS flag set. Setting this entry to On is 
necessary if the memory-resident software needs to be in a critical section to do 
operations off an INT 21 hook. Setting this entry to On will slow down system 
performance slightly. The default is Off. To change this entry, you must edit 
SYSTEM.INI. 

INT28Critical=Boolean 

This entry specifies whether a critical section is needed to handle INT 28h 
interrupts used by memory-resident software. Some network virtual devices do 
internal task switching on INT 28h interrupts. These interrupts might hang some 
network software, indicating the need to add an INT28hCritical= entry. If you 
are not using such software, setting this entry to Off might improve Windows 
task switching. The default is On. To change this entry, you must edit 
SYSTEM.INI. 

IRQ9Global=Boolean 

Keyboard=filename | *devicename 

This entry specifies the keyboard driver for Windows 386 enhanced mode. 
This entry is a synonym for Device=. The default is none. Setup assigns an 
appropriate value based on your system configuration. To change this entry, 
choose the Windows Setup icon from the Main Group window. 

KeyBoostTime=seconds 

This entry specifies how much time an application gets to run with increased 
priority when it receives a keystroke. Use this entry to increase the response 
to keystrokes when several background applications are running. The default is 
.001. To change this entry, you must edit SYSTEM.INI. 

KeyBufferDelay=seconds 

This entry specifies the time to delay pasting keyboard input after the key-
board buffer is full. Some applications might require more than .2 seconds. 
The default is .2. To change this entry, you must edit SYSTEM.INI.  

Flowchart 2.5 
 Cannot Access  
Floppy Drives  

in 386 Enhanced Mode 

This entry, if set to On, converts IRQ 9 masks to global. Set this entry to On 
if your system hangs when it reads from a floppy drive, or to make sure the 
system reads the floppy drive before starting Windows. The default is Off. To 
change this entry, you must edit SYSTEM.INI. 
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KeyIdleDelay=seconds 

This entry specifies how long Windows ignores idle calls after simulating 
a keystroke into a virtual machine. You can set this value to 0 to speed up 
keyboard input, but some applications might respond sluggishly if you do. 
The default is .5. To change this entry, you must edit SYSTEM.INI. 

W KeyPasteCRSkipCount=number 

This entry specifies the number of times that a read-status INT 16 call should 
return a status of “empty” for the keyboard buffer after pasting a carriage return 
and before pasting another character. When Windows pastes data from the Clip-
board to a non-Windows application, it must first paste the data to the BIOS 
keyboard buffer before pasting it into the application. This setting is used to 
slow down fast pasting from the Clipboard to the keyboard buffer so that the 
application can handle all incoming characters from the buffer. If you seem to 
lose characters, or if the screen does not update often enough while pasting 
information from the Clipboard, increase this value. This setting is related to 
KeyPasteSkipCount=. The default is 10. To change this entry, you must edit 
SYSTEM.INI. 

KeyPasteDelay=seconds 

This entry specifies how long to wait before pasting any characters after a key 
has been pasted. Some applications might require more time than .003 seconds 
for recognition of a keystroke. The default is .003. To change this entry, you 
must edit SYSTEM.INI. 

W KeyPasteSkipCount=number 

This entry specifies the number of times that a read-status INT 16 call should 
return a status of “empty” for the keyboard buffer before pasting another 
character. When Windows pastes data from the Clipboard to a non-Windows 
application, it must first paste the data to the BIOS keyboard buffer before 
pasting it into the application. This setting is used to slow down fast pasting 
from the Clipboard to the keyboard buffer so that the application can handle all 
incoming characters from the buffer. If you seem to lose characters, or if the 
screen does not update often enough while pasting information from the 
Clipboard, increase this value. The default is 2. This setting is related to 
KeyPasteCRSkipCount=. To change this entry, you must edit SYSTEM.INI. 

KeyPasteTimeout=seconds 

This entry specifies how much time to allow an application to make the 
necessary BIOS calls for reading keyboard input before Windows will change 
from the fast paste (INT 16h) to the slow paste (INT 9h) mechanism. The default 
is 1. To change this entry, you must edit SYSTEM.INI. 
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 W KybdPasswd=Boolean 

This entry specifies whether the Virtual Keyboard Device (VKD) should support 
PS/2 8042 commands that implement password security. This entry only applies 
to 8042 keyboard controllers that are compatible with the PS/2 computer. The 
default is On for IBM  PS/2 computers; Off for all other computers. To change 
this entry, you must edit SYSTEM.INI.  

 W KybdReboot=Boolean 

If this entry is On, Windows will attempt to reboot the computer using a 
keyboard controller command. On some computers this method is unreliable. 
If your computer hangs while rebooting, then set this entry to Off, in which case 
Windows will quit and display a prompt to press CTRL+ALT+DEL a second time if 
you attempt to reboot from the keyboard while Windows is running. The default 
is On. To change this entry, you must edit SYSTEM.INI.  

Local=device-name 

This entry defines MS-DOS device drivers that need to be local to each virtual 
machine. The device-name value must exactly match the case of the device 
name, or this entry will not work. Most device names are in all capital letters, so 
this value must usually be in all caps. If a device driver is local, a separate copy 
of it will exist in each virtual machine, and each will keep different state 
information. Most device drivers will not function properly when this entry is 
used. An exception is CON, the MS-DOS console device, which should be local 
to avoid filling a buffer with input from multiple virtual machines. The default is 
none; but in a standard SYSTEM.INI file, Setup will set Local=CON. To change 
this entry, you must edit SYSTEM.INI. 

 W LocalLoadHigh=Boolean 

This entry determines how the upper memory blocks (UMBs) are used when 
Windows in running on MS-DOS version 5.0. If this entry is Off, Windows uses 
all of the upper memory area, leaving no extra UMBs available for virtual 
machines. If this entry is On, then Windows does not use all of the upper 
memory area, so the UMBs are available locally to each virtual machine. The 
default is Off. To change this entry, you must edit SYSTEM.INI. 

 W LocalReboot=On | Off 

This entry specifies whether you can press CTRL+ALT+DEL to quit applications 
that cause an unrecoverable error in 386 enhanced mode, without restarting 
Windows. If this setting is On, you can quit the application. If this setting is Off, 
pressing CTRL+ALT+DEL will restart your entire system (as it usually does). To 
change this entry, you must edit SYSTEM.INI. 
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LPT1AutoAssign=seconds 
LPT2AutoAssign=seconds 
LPT3AutoAssign=seconds 
LPT4AutoAssign=seconds 

These entries apply to Windows version 3.0 only. If you have upgraded to 
Windows 3.1, these settings may still appear in your SYSTEM.INI file, but will 
have no effect. The default is 60.   

 W LRULowRateMult=number 

This entry specifies the value used to determine the Least Recently Used (LRU) 
low paging rate sweep frequency, which is computed by multiplying the value 
for LRUSweepFreq= by the value specified for LRULowRateMult=. Values 
between 1 and 65535 can be used. The default is 10. To change this entry, you 
must edit SYSTEM.INI. (You should never need to change this entry.) 

 W LRURateChngTime=milliseconds 

This entry specifies the length of time that the Virtual Memory Manager (VMM ) 
stays at high rate with no paging before switching to low rate, and the length of 
time the VMM  stays at low rate with no paging before turning the LRU sweep 
off. The default is 10,000. To change this entry, you must edit SYSTEM.INI. 
(You should never need to change this entry.) 

 W LRUSweepFreq=milliseconds 

This entry specifies the time between LRU sweep passes. This is also the high 
paging rate sweep frequency. The default is 250. To change this entry, you must 
edit SYSTEM.INI. (You should never need to change this entry.)  

 W LRUSweepLen=length-in-pages 

This entry specifies the length in pages of the region swept on each pass. 
Windows computes this value by dividing the value of LRUSweepReset= by 
the value of LRUSweepFreq=. The value must be at least 1. The default is 
1024. To change this entry, you must edit SYSTEM.INI. (You should never need 
to change this entry.)  

 W LRUSweepLowWater=number 

This entry specifies when the LRU sweeper should be turned on. When the 
number of free pages drops below this value, the sweeper is turned on. The 
default is 24. To change this entry, you must edit SYSTEM.INI. (You should 
never need to change this entry.) 
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 W LRUSweepReset=milliseconds 

This entry specifies the time desired for an ACC bit reset divided by 4 MB 
of pages. Therefore, the time to reset all ACC bits is number of pages in 
system+1023/1024, where 1024 pages = 4 MB. The minimum value is 100. The 
default is 500. To change this entry, you must edit SYSTEM.INI. (You should 
never need to change this entry.)  

MapPhysAddress=range 

This entry specifies the address range (in megabytes) in which the memory 
manager will preallocate physical page-table entries and linear address space. 
Set a value for this entry if you are using an MS-DOS device driver that needs 
this contiguous memory (such as an older version of RAMDrive that uses 
extended memory). The default is none. To change this entry, you must edit 
SYSTEM.INI. 

 W MaxBPs=number 

This entry specifies the maximum number of break points (a method for 
transferring control to Windows 386 enhanced mode) that can be used by the 
VMM . You may need to increase this value if you are using a third-party virtual 
device driver that requires more break points than the default value. The default 
is 200. To change this entry, you must edit SYSTEM.INI. 

 W MaxCOMPort=number 

This entry specifies the maximum number of COM ports supported in 386 
enhanced mode. Change this value if you have more than four COM ports in your 
system. The default is 4. To change this entry, you must edit SYSTEM.INI. 

 W MaxDMAPGAddress=address 

This entry specifies the maximum physical page address that can be used for 
DMA . This entry works only with hard drives that support DMA . The default is 
0FFFh for non-EISA computers; 0FFFFFh for EISA computers. To change this 
entry, you must edit SYSTEM.INI.  

MaxPagingFileSize=kilobytes 

This entry specifies the maximum size for a temporary swap file. The default 
is 50 percent of the available disk space. To change this entry, choose the 386 
Enhanced icon in Control Panel, then choose Virtual Memory to set a value. 

 W MaxPhysPage=hexadecimal-page-number 

This entry specifies the maximum physical page number that the VMM  can 
manage as a useable page, allowing pages to be added at a physical address 
beyond what the VMM  recognized during initialization. If the value specified is 
less than what the VMM  determines, the VMM  will ignore several physical pages 
that it would usually use, preventing the use of memory. This is useful if you are 
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using a hardware device that cannot recognize all of the physical memory in 
your computer (for example, ISA DMA  network cards cannot access physical 
memory above 16 MB). The default is determined by Windows based on the 
highest physical page number detected by the VMM  during initialization. To 
change this entry, you must edit SYSTEM.INI. 

 W MCADMA=Boolean 

This entry specifies whether Windows should use the Micro Channel (MCA) 
extensions to DMA . This entry only applies to MCA computers. Set this entry to 
Off if you are using an MCA computer but the DMA  extensions are not 
implemented. The default is On for most MCA computers; Off for all other 
computers. To change this entry, you must edit SYSTEM.INI. 

 W MessageBackColor=vga-color-attribute 

This entry specifies the background color of message screens, such as the screen 
that appears when you press CTRL+ALT+DEL. The default is 1 (for blue). To 
change this entry, you must edit SYSTEM.INI. 

 W MessageTextColor=vga-color-attribute 

This entry specifies the color used to display text in message screens, such as the 
screen that appears when you press CTRL+ALT+DEL. The default is F (for white). 
To change this entry, you must edit SYSTEM.INI. 

MinTimeSlice=milliseconds 

This entry specifies the minimum time a virtual machine will be allowed to 
run before other virtual machines can take over. A smaller value (such as 10 
milliseconds) will make multitasking appear smoother, but will diminish the 
overall system performance. The default is 20. To change this entry, choose the 
386 Enhanced icon from Control Panel. 

 W MinUnlockMem=kilobytes 

This entry specifies the amount of memory that must remain unlocked and 
available for use when resuming a virtual machine if more than one virtual 
machine is running. The default is 40. To change this entry, you must edit 
SYSTEM.INI. (You should never need to change this entry.)  

MinUserDiskSpace=kilobytes 

This entry tells Windows how much disk space to leave free when creating a 
temporary swap file. Use this entry if your system’s paging drive has less 
available space than Windows can use for paging. This entry has no effect if a 
permanent swap file exists. The default is 500. To change this entry, you must 
edit SYSTEM.INI. 
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Mouse=filename | *devicename 

This entry specifies the virtual device that handles the mouse hardware in 386 
enhanced mode. This entry is a synonym for Device=. The default is none. Setup 
assigns an appropriate value based on your system configuration. To change this 
entry, choose the Windows Setup icon in the Main Group window. 

MouseSoftInit=Boolean 

This entry specifies whether Windows should convert INT 33h function 0 hard 
initialization calls to function 33 soft initialization calls, which do not reset the 
mouse hardware. Set this entry to On if you want to use a mouse with a non-
Windows application started in a window. Set this entry to Off if the cursor and 
screen information appear distorted when you are using the mouse with an 
application. If you set this entry to Off, you will not be able to use the mouse 
with a non-Windows application started in a window. The default is On. To 
change this entry, you must edit SYSTEM.INI. 

NetAsynchFallback=Boolean 

This entry, if set to On, tells Windows to attempt to save a failing NetBIOS 
request. When an application issues an asynchronous NetBIOS request, Windows 
will attempt to allocate space in its global network buffer to receive the data. If 
there is insufficient space in the global buffer, Windows will usually fail the 
NetBIOS request. If this entry is On, Windows will attempt to save such a 
request by allocating a buffer in local memory and preventing any other virtual 
machines from running until the data is received and the timeout period specified 
by NetAsynchTimeout= expires. The default is Off. To change this entry, you 
must edit SYSTEM.INI. 

NetAsynchTimeout=seconds 

This entry specifies the timeout period when Windows needs to enter a critical 
section to service an asynchronous NetBIOS request. This value is used only 
when NetAsynchFallback= is set. This value can include a decimal, such as 0.5. 
The default is 5.0. To change this entry, you must edit SYSTEM.INI. 

NetDMASize=kilobytes 

This entry specifies the DMA  buffer size for NetBIOS transport software if a 
network has been installed. In this case, the buffer size is the larger value 
between this value and the value of DMABufferSize=. The default is 32 on 
Micro Channel machines, and 0 on non−Micro Channel machines. To change 
this entry, you must edit SYSTEM.INI. 
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NetHeapSize=number 

This entry specifies the size, in 4K increments, of the data-transfer buffers that 
Windows 386 enhanced mode allocates in conventional memory for transferring 
data over a network. All values are rounded up to the nearest 4K. The default is 
12. To change this entry, you must edit SYSTEM.INI. 

Network=filename | *devicename 

This entry specifies the type of network used with Windows 386 enhanced 
mode. This entry is a synonym for Device=. The default is none. Setup assigns 
an appropriate value based on your system configuration. To change this entry, 
choose the Windows Setup icon from the Main Group window. 

NMIReboot=Boolean 

This entry, if set to On, causes a reboot to occur when a nonmaskable interrupt 
is received. The default is Off. To change this entry, you must edit SYSTEM.INI. 

NoEMMDriver=Boolean 

This entry, if set to On, prevents Windows 386 enhanced mode from installing 
the expanded memory driver. This differs from setting EMMSize=0, which 
prevents UMBs from being allocated, but does not prevent the EMS driver from 
being loaded. The default is Off. To change this entry, you must edit 
SYSTEM.INI. 

W NoWaitNetIO=On | Off 

This entry specifies whether to convert synchronous NetBIOS commands to 
asynchronous commands. When this entry is On, synchronous NetBIOS 
commands are converted. This can improve overall system performance when 
running several applications. The default is On. To change this value, you must 
edit SYSTEM.INI. 

 W OverlappedIO=Boolean 

This entry, if On, allows several virtual machines to make read and write 
requests to a disk before the first request has been completed. If this entry is Off, 
virtual machines cannot issue a request to read or write to a disk until any 
previous read and write requests have been completed. The default is Off if 
InDOSPolling=on; otherwise, On. To change this entry, you must edit 
SYSTEM.INI. (You should never need to change this entry.)  
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W PageBuffers=number 

This entry specifies the number of 4K page buffers used to store asynchronous 
read and write pages. This setting is used only if you are using 32-Bit Disk 
Access and a permanent swap file. You can specify a value between 0 and 32. 
Increasing this value can improve Windows performance. The default is 4. To 
change this entry, you must edit SYSTEM.INI.  

 W PageOverCommit=megabytes 

This entry specifies the multiplier that determines the amount of linear address 
space the VMM  will create for the system, which is computed by rounding up the 
amount of available physical memory to the nearest 4 MB and then multiplying 
that value by the value specified for PageOverCommit=. Increasing this value 
increases the amount of available linear address space, causing the size of data 
structures to increase. This also increases paging activity proportionately and 
can slow down the system. You can specify a value between 1 and 20. The 
default is 4. To change this entry, you must edit SYSTEM.INI.  

Paging=Boolean 

This entry sets demand paging (virtual memory). Set this entry to Off only if you 
need the disk space that would be used for a temporary swap file. The default is 
On. To change this entry, you must edit SYSTEM.INI. 

PagingDrive=drive-letter 

This entry specifies the disk drive where Windows 386 enhanced mode will 
allocate a temporary swap file. This entry is ignored if you have a permanent 
swap file. If you don’t have a permanent swap file and no drive is specified or 
the specified drive does not exist, Windows attempts to put the temporary swap 
file on the drive containing the SYSTEM.INI file. If the specified drive is full, 
paging will be turned off. The default is none. To change this entry, you must 
edit SYSTEM.INI. 

W PagingFile=path-and-filename 

This entry specifies the path and filename for the temporary swap file that is 
created when you start Windows in 386 enhanced mode. This file is deleted 
when you quit Windows. This setting overrides the PagingDrive= setting. 
The default is WINDOWS\WIN386.SWP. To change this entry, you must 
edit SYSTEM.INI.  
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 W PerformBackfill=Boolean 

This entry specifies whether to allocate a full 640K of memory to a computer 
that has less than 640K of base conventional memory. Setting this entry 
overrides the automatic checking done by Windows. The default is On 
(Windows automatically checks to see if it needs to fill in memory based on how 
MS-DOS is occupying memory.) To change this entry, you must edit 
SYSTEM.INI. (You should never need to change this entry, because Windows 
can automatically detect whether to perform a backfill.) 

W PermSwapDOSDrive=drive-letter 

This entry specifies the disk drive where Windows in 386 enhanced mode will  
create a permanent swap file. This setting is ignored if you are using a temporary 
swap file. The default is none.  To change this entry, choose the 386 Enhanced 
icon from Control Panel. 

W PermSwapSizeK=kilobytes 

This entry specifies the desired size of a permanent swap file. The default is 
none. To change this entry, choose the 386 Enhanced icon from Control Panel. 

PerVMFILES=number 

This entry specifies the number of private file handles Windows should allocate 
to each virtual machine. Increase this value if an application does not have 
enough file handles to run. The total number of file handles, including the global 
handles specified in the files= statement in CONFIG.SYS, cannot exceed 255. If 
it does exceed 255, this value will be rounded down. Set this value to 0 to 
prevent the allocation of any private file handles. The default is 10; if the MS-
DOS Share utility is installed, this setting in SYSTEM.INI is ignored. To change 
this entry, you must edit SYSTEM.INI. 

PSPIncrement=number 

This entry specifies the amount of additional memory, in 16-byte incre-
ments, that Windows should reserve in each successive virtual machine when 
UniqueDosPSP=on. The value that will work best for your machine might 
vary depending on the memory configuration and the applications you are 
running. Valid values are 2 through 64. The default is 2. See UniqueDosPSP= 
for more information. To change this entry, you must edit SYSTEM.INI. 

ReflectDosInt2A=Boolean 

This entry indicates whether Windows should consume or reflect MS-DOS 
INT 2A signals. If the value is Off, Windows will consume these signals and 
therefore run more efficiently. Set this entry to On if you are running memory-
resident software that relies on detecting INT 2A messages. The default is Off. 
To change this entry, you must edit SYSTEM.INI. 
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 W ReservedHighArea=paragraph-range 

This entry specifies a range of memory that Windows will not scan to find 
unused address space. This also turns off the RAM and ROM search code for 
the range. This scanning can interfere with some adapters that use the same 
memory area. The range (two paragraph values separated by a hyphen) must 
be between A000 and EFFF. The starting value is rounded down and the ending 
value is rounded up to a multiple of 4K. For example, you could set 
ReservedHighArea=E100-E3FF to prevent Windows from scanning the 
first 12K of memory starting at E100. You can specify more than one range 
by including more than one ReservedHighArea= entry. The default is none. To 
change this entry, you must edit SYSTEM.INI.  

ReservePageFrame=Boolean 

This entry tells Windows whether to give preference to EMS page frame space or 
conventional memory when it has to use one of them to allocate MS-DOS 
transfer buffers. This choice is necessary when Windows cannot find space 
between 640K and 1 MB other than EMS page frame space. If set to On, this 
entry will preserve EMS page frame space at the expense of conventional 
memory. If you are not going to run non-Windows applications that use 
expanded memory, set this entry to Off to give non-Windows applications 
more conventional memory. The default is On. To change this entry, you must 
edit SYSTEM.INI. 

 W ReserveVideoROM=Boolean 

This entry, if On, tells Windows that video ROM exists in pages C6 and C7. If 
the text font appears scrambled when you start non-Windows applications, set 
this entry to On. The default is Off. To change this entry, you must edit 
SYSTEM.INI. (You should not need to change this entry, because the default 
value causes Windows to detect video ROM correctly.) 

 W ROMScanThreshold=number 

This entry specifies a parameter used to determine whether an area of memory in 
the adapter area (usually between C000-EFFF) is ROM when the area has no 
ROM header or incorrect header information. The number for this entry specifies 
how many transitions (value changes) must occur within the memory area to 
determine whether it is ROM. If the number of transitions is greater than the 
value for this entry, Windows recognizes the memory as ROM. If the number of 
transitions is less than the value, Windows recognizes the memory as usable 
memory. Specifying 0 causes Windows to recognize the memory area as ROM 
and then reserve it as unusable. The default is 20. (You should never need to 
change this entry.) 
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W ScrollFrequency=number 

This entry specifies the number of lines you can scroll in a non-Windows 
application that is running in Windows before its display is updated. The default 
is 2. You should never need to change this setting. 

SGrabLPT=port-number 

This entry routes all printer interrupts on the specified port to the system virtual 
machine rather than to the current virtual machine. The default is none. To 
change this entry, you must edit SYSTEM.INI. 

 W SyncTime=Boolean 

This entry, if On, causes Windows to periodically synchronize its time with the 
computer’s CMOS clock. If this entry is Off, Windows usually maintains the 
correct time, unless TrapTimerPorts=off when you are running applications 
that can cause the system time to run faster or slower than the actual time. The 
default is On. To change this entry, you must edit SYSTEM.INI. 

SystemROMBreakPoint=Boolean 

This entry specifies whether Windows should use ROM address space between 
F000:0000 and 1 MB for a break point. Windows 386 enhanced mode usually 
searches this space to find a special instruction that is used as a system break 
point. If this address space contains something other than permanently available 
ROM, set this entry to Off. The default is On if Windows is started in real mode 
of the 80386/486 CPU. Off if Windows is started in virtual mode of the 
80386/486 CPU. Most 386 memory managers, such as QEMM and 386MAX, 
require this value to be set to Off. If a 386 memory manager is running, 
Windows is started in virtual mode. Otherwise, Windows is started in real mode. 
To change this entry, you must edit SYSTEM.INI. 

SysVMEMSLimit=number | kilobytes 

This entry specifies how many kilobytes of expanded memory Windows should 
be permitted to use. Setting this value to 0 prevents Windows from gaining 
access to any expanded memory. Setting it to -1 gives Windows all the available 
expanded memory that it requests. The default is 2048. To change this entry, you 
must edit SYSTEM.INI. 

SysVMEMSLocked=Boolean 

This entry indicates whether to swap to the hard disk the expanded memory 
being used by non-Windows applications. Locking expanded memory can im-
prove the performance of a non-Windows application that uses it, but locking 
it slows down the rest of the system. The default is Off. To change this entry, 
you must edit SYSTEM.INI. 
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SysVMEMSRequired=kilobytes 

This entry specifies how much expanded memory must be free to start Windows. 
Leave this value at 0 if no non-Windows application running under Windows 
will require expanded memory. The default is 0. To change this entry, you must 
edit SYSTEM.INI. 

SysVMV86Locked=Boolean 

This entry, if set to On, causes the virtual-mode memory being used in the 
system virtual machine to remain locked in memory rather than being swappable 
out to disk. Because Windows handles this process, there is no known reason to 
set this entry. The default is Off. To change this entry, you must edit 
SYSTEM.INI. 

SysVMXMSLimit=number | kilobytes 

This entry specifies the maximum amount of memory the extended memory 
driver will allocate to MS-DOS device drivers and memory-resident software in 
the system virtual machine. Set the value to -1 to give an application all the 
available extended memory that it requests. The default is 2048. To change this 
entry, you must edit SYSTEM.INI. 

SysVMXMSRequired=kilobytes 

This entry specifies how many kilobytes of extended memory must be reserved 
by the XMS driver to start Windows. Leave this value at 0 if there are no XMS 
users in the system virtual machine. The default is 0. To change this entry, you 
must edit SYSTEM.INI. 

TimerCriticalSection=milliseconds 

This entry instructs Windows to go into a critical section around all timer 
interrupt code, and specifies a timeout period. Specifying a positive value will 
ensure that only one virtual machine at a time receives timer interrupts. Some 
networks and other global memory-resident software may fail unless this entry is 
used. However, using this entry will slow down performance and can make the 
system sluggish or seem to stop for short periods of time. The default is 0. To 
change this entry, you must edit SYSTEM.INI. 

TokenRingSearch=Boolean 

This entry, if On, tells Windows whether to search for a token ring network 
adapter on machines with IBM  PC/AT architecture. Set this entry to Off if you 
are not using a token ring card and the search interferes with another device. The 
default is On. To change this entry, you must edit SYSTEM.INI. 
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TranslateScans=Boolean 

This entry, if On, indicates whether Windows will translate a keyboard’s scan 
codes to make them compatible with standard IBM  scan codes. This entry is 
necessary only for keyboards that generate nonstandard scan codes. This entry is 
used only for the Switcher Screen and full-screen message boxes. The default is 
Off. To change this entry, you must edit SYSTEM.INI. 

 W TrapTimerPorts=Boolean 

If this entry is set to Off, Windows allows applications to read from and write to 
the system timer ports. In this case, Windows can usually detect when an 
application has changed the timer interrupt interval and then make any adjust-
ments to the time. However, some applications may prevent Windows from 
keeping accurate time. If your system’s time appears to be running fast or slow, 
set this entry to On, so that Windows will deny access to the timer ports. This 
ensures that the system time will be accurate, but may cause applications that 
frequently access the timer ports to run slowly. If you do not want to set this 
entry to On, set SyncTime=On, which causes Windows to restore the correct 
time periodically regardless of whether applications access the timer ports. The 
default is On. To change this entry, you must edit SYSTEM.INI.  

UniqueDOSPSP=Boolean 

This entry, if set to On, tells Windows to start every application at a unique 
address (PSP). Each time Windows creates a new virtual machine to start a new 
application, Windows reserves a unique amount of memory (i bytes) below the 
application. For example, the first application would be loaded at address M, the 
second at address M+i, the third at M+2i, and so forth. The amount of memory 
(i) is determined by PSPIncrement=. These entries ensure that applications in 
different virtual machines all start at different addresses. Some networks use 
applications’ load addresses to identify the different processes using the 
network. On such networks, setting this entry to Off might cause one application 
to fail when you exit another, because the network interprets them as the same 
application. However, setting this entry will leave slightly less memory for non-
Windows applications. The default is On if you are running a network based on 
Microsoft Network (MS-Net) or LAN  Manager; Off for all other networks. See 
Chapter12, “Networks and Windows 3.1,” to find out if your network is based 
on MS-Net or LAN  Manager. To change this entry, you must edit SYSTEM.INI. 

 W UseableHighArea=paragraph-range 

This entry specifies the range of memory that Windows will scan for unused 
address space regardless of what may be there. UseableHighArea= takes 
precedence over ReservedHighArea= if you specify ranges that overlap. The 
range (two values separated by a hyphen) must be between A000 and EFFF. 
The starting value is rounded down and the ending value is rounded up to a 
multiple of 4K. For example, you could set UseableHighArea=E100-E3FF to 
ensure that Windows scans the first 12K of memory starting at E100.  



216 Part 1   Installation and Setup 

Windows Resource Kit   

You may specify more than one range by including more than one entry for 
UseableHighArea=. The default is none. To change this entry, you must edit 
SYSTEM.INI.  

UseInstFile=Boolean 

This entry specifies whether Windows should look in the INSTANCE.386 file for 
information it can use to determine whether data structures within MS-DOS need 
to be local. Two other methods give Windows this information: internal tables 
within the device, and an INT 2Fh call documented in the OEM Adaptation Kit. 
Both methods are preferable to using this setting; this entry is provided only for 
compatibility with Windows/386 version 2.x. The default is Off. To change this 
entry, you must edit SYSTEM.INI. 

 W UseROMFont=Boolean 

This entry, if On, causes Windows to use the soft font stored in video ROM for 
displaying messages that appear when non-Windows applications are running in 
a full screen and for displaying the text that appears when switching away from a 
non-Windows application. Set this entry to Off if the font used to display 
messages is different from the font used in the application, or if random dots and 
shapes appear on your screen. The default is On. To change this entry, you must 
edit SYSTEM.INI.  

 W VGAMonoText=Boolean 

This entry tells Windows to ignore the video memory address space in VGA 
displays, usually used for monochrome adapters. When this entry is Off, 
Windows can use the B000h through B7FF range in upper memory if no 
hardware device is using these addresses and other applications do not use the 
monochrome display mode of the VGA adapter. This entry applies only to VGA 
displays. The default is On. To change this entry, you must edit SYSTEM.INI. 

 W VideoBackgroundMsg=Boolean 

This entry, if On, causes Windows to display a message when a background 
application is suspended, or if its display cannot be updated properly because 
video memory is low. Setting this entry to Off turns off the warning message. 
This entry affects all non-Windows applications currently running. The default is 
On. To change this entry, you must edit SYSTEM.INI. 

 W VideoSuspendDisable=Boolean 

This entry specifies whether to suspend an application running in the back-
ground if its display becomes corrupted. If this entry is On, the application will 
continue running. If it is Off, applications will be suspended, and a warning 
message will appear if the VideoBackgroundMsg=On. This entry applies only 
to VGA displays. The default is Off. To change this entry, you must edit 
SYSTEM.INI.  
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VirtualHDIrq=Boolean 

WindowKBRequired=kilobytes 

This entry specifies how much conventional memory must be free to start 
Windows. The default is 256. To change this entry, you must edit SYSTEM.INI. 

WindowMemSize=number | kilobytes 

This entry limits the amount of conventional memory Windows can use for 
itself. The default value indicates that Windows can use as much conventional 
memory as it needs. Try entering a positive value less than 640 if there is not 
enough memory to run Windows in 386 enhanced mode. The default is -1. To 
change this entry, you must edit SYSTEM.INI. 

WindowUpdateTime=milliseconds 

This entry specifies the time Windows takes between updates of the display for a 
non-Windows application running in a window. The default is 50. To change 
this entry, you must edit SYSTEM.INI. 

WinExclusive=Boolean 

This entry, if On, indicates whether Windows always gets all of the computer’s 
processing time whenever a Windows application is in the foreground. If this 
entry is On and a Windows application is in the foreground, no non-Windows 
application will run. The default is Off. To change this entry, choose the 386 
Enhanced icon from Control Panel. 

Flowcharts 2.5-2.6 
 Cannot Access  
Floppy Drives  
or Hard Disk 

This entry allows Windows 386 enhanced mode to terminate interrupts from the 
hard disk controller, bypassing the ROM routine that handles these interrupts. 
Some hard drives might require that this entry be set to Off for interrupts to be 
processed correctly. If this entry is set to Off, the ROM routine handles the 
interrupts, which slows the system’s performance. The default is On for AT-
compatible computers; Off for other computers. To change this entry, you must 
edit SYSTEM.INI. 
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WinTimeSlice=number,number 

This entry contains two numbers. The first number specifies the relative pro-
cessing time (based on MinTimeSlice=) given to all Windows applications 
running in the foreground relative to the time allocated to all non-Windows 
applications running in the background. The second number specifies the 
relative processing time given to all Windows applications running in the 
background when a non-Windows application is running in the foreground. The 
range of numbers that can be entered is 1 through 10000. The important value is 
the ratio of these values to the corresponding settings in the PIFs of the active 
non-Windows applications. The default is 100,50. To change this entry, choose 
the 386 Enhanced icon from Control Panel. 

 W WOAFont=font filename 

This entry specifies which font files are loaded into memory when running non-
Windows applications. These fonts are also available to Windows applications 
as long as a non-Windows application is running. If you want to make these 
fonts always available to Windows applications, add them to your system with 
the Fonts option in Control Panel. The default is DOSAPP.FON. To change this 
entry, exit Windows and run Setup from MS-DOS, then change the Codepage or 
Display setting. 

 W XlatBufferSize=kilobytes  

This entry specifies the size of the low-memory buffer used to map MS-DOS 
calls from protected mode to virtual 386 enhanced mode. Specifying a higher 
value can improve the performance of protected-mode Windows applications 
that read or write information in a large number of bytes (for example, some 
database applications). However, this may decrease the amount of memory 
available for running non-Windows applications and may cause problems on 
networks that use named pipes. These networks may require a value of 4. The 
value you specify is rounded to the next 4K increment. For example, if you set 
this value to 5, Windows rounds it up to 8. The default is 8. To change this 
entry, you must edit SYSTEM.INI. 

 W XMSUMBInitCalls=Boolean 

This entry specifies whether Windows should call the extended memory driver’s 
UMB management routines. The default is usually On, but may be Off 
depending on the extended memory manager you are using. You should never 
need to change this entry. 
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Other Windows Initialization Files 

Your WINDOWS directory includes at least three other initialization files:  
PROGMAN.INI, CONTROL.INI, and WINFILE.INI . These files contain the initial 
settings for elements defined by Program Manager, Control Panel, and File 
Manager, respectively.  

Many other Windows applications create initialization files to store specific 
settings for the application. These files also appear in the WINDOWS directory 
with .INI filename extensions. 

PROGMAN.INI: The Program Manager Initialization File 

The Program Manager initialization file, PROGMAN.INI, usually has entries for 
[settings] and [groups], which describe what should appear in the Program 
Manager window when you run Program Manager. To change the appearance 
and behavior of Program Manager, use the menu commands as described in 
Chapter 3, “Program Manager,” in the Windows User’s Guide. 

A system administrator might also choose to add a third section, [restrictions], 
for custom installations. For more information about creating custom entries for 
PROGMAN.INI for multiple systems during Windows installation, see 
“Configuring Program Manager for a Network Workgroup” in Chapter 6, “Tips 
for Configuring Windows 3.1.” 

[settings] 

The [settings] section usually has these entries: 

[Settings] 
Window=60 28 565 388 1 
SaveSettings=1 
MinOnRun=0 
AutoArrange=1 
Startup= 
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Entry Value  

Window= Four numbers that indicate the position of the window when Program 
Manager is opened, followed by a 1 if the window is maximized. 

SaveSettings= 1 if the Save Settings On Exit command on the Options menu is checked in 
Program Manager. In this case, Program Manager will save the current 
configuration when you close Windows. 

MinOnRun= 1 if the Minimize On Use command is checked on the Options menu in 
Program Manager. In this case, the Program Manager will be iconized when 
you run another application. 

AutoArrange= 1 if the AutoArrange command is checked on the Options menu in Program 
Manager. In this case, the icons in each group will be automatically arranged 
when you run Program Manager. 

Startup= Name of the group that serves as the “startup” group. If this entry is blank, 
the Startup group created in Windows Setup is the startup group. 
 

[groups] 

The PROGMAN.INI file will also have a section named [groups], which has 
entries such as these: 

[Groups] 
Group1=C:\WINDOWS\ACCESSOR.GRP 
Group2=C:\WINDOWS\GAMES.GRP 
Group3=C:\WINDOWS\ALDUS.GRP 
Group5=C:\WINDOWS\WORDFORW.GRP 
Group6=C:\WINDOWS\MAIN.GRP 
Group7=C:\WINDOWS\STARTUP.GRP 
Order= 8 7 2 3 5 1 6 
Group8=C:\WINDOWS\APPLICAT.GRP 

Entry Value 

Groupx=  A filename (with full path) for the .GRP file that contains the group created 
during Setup, or created when an application was installed, or that you 
created in Program Manager. 

Order=  A list of numbers separated with spaces, indicating the order in which the 
groups are drawn in the window.  
 

To change these settings, we recommend that you use the commands on the 
Program Manager menu. 
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[restrictions] 

W For network system administration, you can also add a [restrictions] section to 
PROGMAN.INI to restrict user actions. The [restrictions] section can have these 
entries: 

[restrictions] 
NoRun= 
NoClose= 
NoSaveSettings= 
NoFileMenu= 
EditLevel= 

Entry Value 

NoRun= 1 disables the Run command on the File menu. The Run command will 
appear dimmed on the File menu and the user will not be able to run 
applications from Program Manager unless the applications are set up as 
icons in a group.  

NoClose= 1 disables the Exit Windows command on the File menu. Users will not be 
able to quit Program Manager through the File Menu or the Control menu 
(the Exit Windows and Close commands will be dimmed), or by using 
ALT+F4.  

NoSaveSettings= 1 disables the Save Settings on Exit command on the Options menu. The 
Save Settings command will appear dimmed on the Options menu and any 
changes that the user makes to the arrangement of windows and icons will not 
be saved when Windows is restarted. This setting overrides the 
SaveSettings= entry in the [Settings] section of the PROGMAN.INI file.  

NoFileMenu= 1 removes the File menu from Program Manager. All of the commands on 
that menu will be unavailable. Users can start the applications in groups by 
selecting them and pressing ENTER, or by double-clicking the icon. Unless 
you have also disabled the Exit Windows command, users can still quit 
Windows by using the Control menu or ALT+F4.  

EditLevel=n Sets restrictions for what users can modify in Program Manager. You can 
specify one of the following values for n:  

 0 allows the user to make any change. (This is the default value.)  

 1 prevents the user from creating, deleting, or renaming groups. If you specify 
this value, the New, Move, Copy, and Delete commands on the File menu are 
not available when a group is selected.  

 2 sets all restrictions in EditLevel=1, plus prevents the user from creating or 
deleting program items. If you specify this value, the New, Move, Copy, and 
Delete commands on the File menu are not available at all.  

 3 sets all restrictions in EditLevel=2, plus prevents the user from changing 
command lines for program items. If you specify this value, the text in the 
Command Line box in the Properties dialog box cannot be changed.  

 4 sets all restrictions in EditLevel=3, plus prevents the user from changing 
any program item information. If you specify this value, none of the areas in 
the Properties dialog box can be modified. The user can view the dialog box, 
but all of the areas are dimmed.  
 

To enable any of the commands or remove any of the EditLevel= restrictions, 
either remove the entry from the PROGMAN.INI file, or set the value to 0.  
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CONTROL.INI:  Control Panel Initialization File 

The CONTROL.INI file contains several sections that specify the options you set 
by choosing icons in Control Panel.  

Section Values specified 

[Current] Specifies the current color scheme. 

[Color Schemes] Defines the colors for each element of specific color schemes, as set by 
choosing the Color icon. 

[Custom Colors] Defines the custom colors in the color palette, as set by choosing the Color 
icon. 

[Patterns] Defines the color values for the bitmap patterns, as set by choosing the 
Desktop icon. 

[MMCPL] Specifies values related to the multimedia items in Control Panel. 

[Screen Saver.* ] Specifies the density, warp speed, and password-protection values for the 
screensaver. 

[Userinstallable.drivers]  
Specifies values related to installable drivers used for multimedia. 

[Drivers.Desc] Specifies the MIDI Mapper and Time, the multimedia control devices. 

[Installed] Specifies the current version of Microsoft Windows and the installed printers. 
 

To change any of these items, choose the related icons in Control Panel, as 
described in Chapter 5, “Control Panel,” in the Windows User’s Guide. 
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WINFILE.INI:  The File Manager Initialization File 

The WINFILE.INI  file contains one section, [settings], to specify the options 
you can set by choosing menu commands in File Manager. For example, these 
settings might appear in WINFILE.INI : 

[Settings] 
Window=0,6,800,600, , ,1 
dir1=48,7,543,236,-1,-1,3,30,201,1808,150,B:\*.* 
Face=Small Fonts 
Size=8 
LowerCase=1 
ConfirmDelete=0 
ConfirmSubDel=0 
ConfirmReplace=1 
ConfirmMouse=1 
ConfirmFormat=1 

Entry Value 

Window= The size and position of the window and whether it is maximized when 
opened. 

dir1= The current directory settings. 

Face= The name of the typeface used for desktop items. The default is Small Fonts. 

Size= The point size for the typeface. The default is 8. 

LowerCase= 1 if filenames are to appear in lowercase. 

ConfirmDelete= 1 if the user is to be prompted to confirm file deletion requests.  

ConfirmSubDel= 1 if the user is to be prompted to confirm subdirectory deletion requests.  

ConfirmReplace= 1 if the user is to be prompted to confirm file replacement requests.  

ConfirmMouse= 1 if the user is to be prompted to confirm mouse drag-and-drop requests.  

ConfirmFormat= 1 if the user is to be prompted to confirm formatting requests.  
 

To change values for these settings, use the menu commands in File Manager, as 
described in Chapter 4, “File Manager,” in the Windows User’s Guide. 
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